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The monitor dis-
plays video as 
you import it or 
play it back.

Switch between 
the clip viewer and 
the timeline viewer 
(page 231).

The scrubber  
bar lets you move 
through and crop 
a clip (page 228).

Your project’s 
video format 
appears here  
(page 224).

Adjust the  
playback volume 
as you work in 
iMovie HD.

Video can be a powerful vehicle for com-
municating an idea, setting a mood, selling 
a product, or recalling a memory. It can 
also be great way to put people to sleep.

Video editing is the process of assem-
bling video clips, still images, and audio 
into a finished package that gets your mes-
sage across and keeps your audience’s eyes 
open. Video editing is what iMovie HD is 
all about.

With iMovie HD, you can import 
video from a video camera. iMovie HD 
stashes incoming clips on its Clips pane.  
If you’re using a miniDV or HDV camera, 
iMovie HD even controls your camera 
during the importing process.

Then, you edit clips and sequence them 
by dragging them to the timeline, option-
ally adding music from your iTunes music 
library and creating titles, effects, and 
scene transitions. When you’re finished, a 
few mouse clicks send your efforts back out 
to tape or to iDVD.

You can use iMovie HD to edit inter-
minable home movies, but you can also use 
it to assemble montages of photos from 
iPhoto, promotional videos, and anything 
else that belongs on the small screen. iMovie 
HD supports more video formats than did 
earlier iMovie versions, and that means more 
options for you.

Quiet on the set.

iMovie HD at a Glance

Chapters pane: create 
DVD or podcast chapter 
markers before sending 
your movie to iDVD, 
iWeb, or GarageBand 
(page 266).

Clips pane:  
rename and work with 
imported clips and still 
images (page 228). Themes pane: build 

graphical openers, titles,  
and bumpers using pre-
built themes (page 258)

Media pane: import 
photos from your iPhoto 
library and optionally 
apply the Ken Burns 
effect (pages 236– 
240); also, import  
music from your  
iTunes library or add 
sound effects or narra-
tion (pages 242–244).

Editing pane: create 
titles, add visual transi-
tions between clips, and 
create special visual 
effects (pages 252–256).

The playhead indicates 
the current playback 
location. Drag it left and 
right to quickly move 
backward and forward 
within your movie or 
within a single clip.

These buttons switch 
between iMovie HD’s 
panes, each of which 
lets you work with a dif-
ferent kind of element.

Create bookmarks to 
aid in editing and trim-
ming clips (page 232).

You can sequence clips 
by dragging them from 
the Clips pane to the 
timeline (page 230).

Display a track’s audio 
waveform to be able 
to see changes in the 
audio (page 246).

Video clips and  
still images that you 
import are stored in 
the Clips pane until 
you add them to  
the timeline.

Drag the zoom 
slider to zoom in 
and out on the 
timeline.

Switch between 
camera mode  
(to import video) 
and edit mode 
(page 226).

Adjust the  
audio levels of 
individual clips 
(page 246).

Rewind, start and 
stop playback, and 
play back in full-
screen mode.

iMovie HD dis-
plays remaining 
free disk space 
here.

Reclaim disk 
space by empty-
ing the iMovie HD 
trash (page 229).
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Editing video is one of the most complex 
tasks you will perform in iLife. Not that 
it’s technically difficult—iMovie HD, 
FireWire, and the latest video formats  
have made it easier than ever.

But editing video can be time consum-
ing and labor intensive. Bringing media 
into iMovie HD, fine-tuning the length of 
clips, timing shots to match a music track, 
adding transitions and effects—it all takes 
time. But as a creative exercise, video edit-
ing is hard to beat.

If you’re new to video editing, start 
small. Create a short movie—between 
30 and 90 seconds. Try your hand at a  
simple music video: some video, some still 
photos from iPhoto, and a music soundtrack 
from iTunes. Your first effort shouldn’t be 
an epic; it should be a short story, or even a 
single well-wrought paragraph. That’s the 
best way to learn the art and science of edit-
ing—and to appreciate its magic.

The Essentials of Movie Making
Video Editing: The Big Picture

Import Assets
Bring in video from a camcorder and, optionally,  
add photos and music from iTunes.

 

Trim the Fat
Use iMovie HD’s crop markers and Crop command 
to discard unwanted portions of clips.

Sequence Clips
Drag clips to the timeline viewer and clip viewer to 
add them to your final movie. Trim clips as needed 
to fine-tune their length.

Add Eye Candy
Create transitions between 
clips, and add titles and any 
special effects.

Polish
If you’ve added 
music or other 
audio tracks, you’ll 
want to fine-tune 
audio levels for 
each track.

Export
Record your movie back to tape, send it 
to iDVD, GarageBand, or iWeb; or export 
it as a QuickTime movie for playback on 
an iPod or other device.

spread M02

aspect ratio  The relationship  

of height to width in an image.  

A standard-definition TV image 

has an aspect ratio of 4:3—four 

units of width for each three 

units of height. 

clip  A piece of video footage or 

a still image. A finished movie 

generally contains multiple clips, 

sequenced on the timeline.

FireWire  The high-speed 

interface used to connect video 

gear, such as a miniDV cam-

corder, to the Mac. Also used for 

other devices, including hard 

drives and, of course, the iPod.

frame  A single still image in a 

movie clip, and the smallest unit 

of a movie clip you can work 

with. One second of video 

contains 30 frames.

HDV  Short for high-definition 

DV, an up-and-coming video for-

mat that stores ultra-sharp video 

on standard miniDV cassettes.

miniDV  Often abbreviated DV,  

a video format that stores high-

quality video and stereo audio 

on a tiny cassette. The miniDV 

format has been a major factor 

in the digital-video revolution. 

playhead  iMovie HD’s equiva-

lent to the blinking cursor in a 

word processor. As a clip plays 

back, the playhead moves to 

show where you are in relation 

to the entire movie or video clip. 

rendering  The process of 

creating frames for a transition, 

title, or effect.

transition  A special effect 

that acts as a segue between 

two clips.

track  An independent stream of 

audio or video. iMovie HD lets 

you have one video track and 

two separate audio tracks.

A Short Glossary of Video Terms
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How Square Are Your Movies?
Many of the differences among video formats aren’t visible at 
first glance, but one of the differences definitely is: the aspect 
ratio of the video frame.

We encountered the concept of aspect ratio when looking at 
iPhoto cropping techniques (page 137). The phrase simply 
describes how square or rectangular an image frame is.

Early iMovie HD 
versions were 
limited to one 
aspect ratio: the 
standard 4:3 
ratio used by 
most TV sets, DV 
camcorders, and 
digital cameras.

Going wide. iMovie HD adds the ability to work with and  
create widescreen video in the 16:9 aspect ratio—the format 
common in high-definition TV sets.

The widescreen format provides a more cinematic experience. 

Pronunciation guide. Making video small talk at the local cof-
fee shop? The expressions 4:3 and 16:9 are usually pro-
nounced “four by three” and “sixteen by nine.” Technically, 
“four to three” and “sixteen to nine” are more accurate, since 
these expressions are ratios. After all, when was the last time 
you heard a bookie describe “2 by 1” odds on a horse?

Four units of width...

...for every three units of height.

If you have a standard, miniDV camcorder 
and you’re anxious to start making movies, 
feel free to skip this little lesson and move 
on to page 226. But if you want to use 
video from a different kind of device—or 
you’re curious about one of iMovie HD’s 
most intriguing capabilities—read on.

Just as music and photos can be stored 
in a variety of digital formats, video also 
comes in several flavors. And, as with 
music and photos, each video format takes 
its own approach to organizing the bits and 
bytes that make up your media.

In early iMovie versions, projects were 
based on one video format: DV. You could 
import other formats into iMovie, but 
iMovie would convert that footage into DV 
format. DV was iMovie’s native tongue, and 
using other formats meant a translation step 
that took time, used up disk space, and 
often compromised video quality.

Times change. New types of video 
devices have appeared, and iMovie has 
evolved to keep pace: iMovie HD provides 
native support for several video formats. 
iMovie HD is multilingual, and as a result, 
you have the flexibility to edit video from a 
wider variety of video devices, ranging from 
Apple’s inexpensive iSight to many digital 
camera models to the new breed of high-
definition HDV cameras from companies 
such as Sony and JVC.

iMovie HD’s basic operation is identi-
cal regardless of which video format you 
use. There are some subtleties to some 
formats, and I’ll share them as we go. 
But first, let’s look at the video languages 
iMovie HD understands.

A Short Lesson in Video Formats

Normally, iMovie HD projects are based 
on the DV format. If you’re using a stan-
dard miniDV camcorder with its factory 
settings, you don’t have to bother with 
choosing a format since iMovie HD is 
preset to speak its mother tongue.

If you’re using a different kind of device 
or you’ve set your DV camera to 16:9 
mode, you need to tell iMovie HD which 
format to use. You do that when creating 
a new project.

To access the Format pop-up menu,  
click the triangle. 

DV. By far the most common format 
used by digital camcorders, and the for-
mat iMovie HD uses for any new project 
unless you specify otherwise. Now that 
the era of high-definition TV is upon us, 
the DV format is often described as a 
standard definition format.

DV Widescreen. Most DV camcorders 
can shoot in widescreen mode, often by 
simply cropping the top and bottom of 
the video frame. (To shoot in this mode, 
use your camcorder’s menus to activate 
16:9 mode.) You don’t get the picture 
quality of high-definition TV, but you do 
get that cinematically wide image.

HDV 1080i and HDV 720p. High defini-
tion (HD, for short) TV is gradually gain-
ing momentum, and the new breed of 
HDV camcorders is helping. The HDV 

format brings high-definition videography 
to advanced amateurs and budget-
minded professionals (and, as prices 
come down, to the rest of us). HDV 
always uses a 16:9 aspect ratio. For 
more information on the HDV format,  
see page 262.

MPEG-4. Many digital cameras shoot 
their movie clips in this format, as do a 
growing number of compact video cam-
eras that connect via USB. For tips on 
importing and working with MPEG-4 
clips, see page 263.

iSight. Apple’s inexpensive iSight cam-
era, which is built into some current Mac 
models, is designed for video chatting 
using iChat AV, but makes a great low-
budget TV camera, too. For advice on 
shooting with an iSight, see page 263.

Choosing a Video Format

Sometimes, you may want to—

or have to—mix video formats 

within a single project. Maybe 

you have a digital camera movie 

clip that you want to add to a 

project that’s in DV format. Or 

perhaps you have some 16:9 DV 

footage that you want to include 

in a 4:3 DV project. Or maybe 

you’re making a montage of 

MPEG-4 digital camera movies, 

but you’re using the DV format 

so you can output the final mon-

tage to a miniDV camcorder.

You can do all of these things 

and more. If you import a movie 

clip in which the video format 

differs from your project’s for-

mat, iMovie HD converts the clip 

into whatever format your project 

uses. This conversion process is 

called transcoding, but you can 

also call it waiting—it can take 

a long time. And use a lot of 

disk space. 

Say you import an MPEG-4  

digital camera movie clip into a 

DV project. The movie clip might 

have a small frame size and use 

only 20MB of disk space, but in 

order to make it compatible with 

your DV-based project, iMovie 

HD will change its frame size 

and other characteristics to con-

form to the DV standard. The 

DV version of that movie might 

take up 120MB.

For these reasons, it’s best to 

stick with one video format 

within a single project. But when 

you don’t have a choice, iMovie 

HD is ready—provided you have 

the time and the disk space.

Mixing Video Formats in a Single Project

Sixteen units of width...

...for every nine units of height.

In this chapter, look for the  for 
information specific to HDV editing.
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To make your imported video 

easy to work with, use iMovie 

HD’s scene-detection feature, 

which causes iMovie HD to 

begin a new clip each time it 

detects a scene break. (Your 

camcorder generates a scene 

break automatically each time 

you press its Record button.) 

To turn on scene detection, 

choose Preferences from the 

iMovie HD menu, then click the 

Import button in the Preferences 

dialog box. Next, click the check 

box labeled Start a new clip at 

each scene break.

Using iMovie HD’s Scene-Detection Feature

Click the camera icon 
and choose your camera 
from the popup list to put 
iMovie HD in camera mode.

iMovie HD displays each 
clip you import on the 
Clips pane.

Tip: You can also have 
iMovie HD add imported 
clips directly to the time-
line; in the Import portion 
of the Preferences dialog 
box, click the Movie 
Timeline button.

iMovie HD displays the 
time code that your 
camera recorded on the 
tape. This can help you 
keep track of where you 
are on a tape as you fast-
forward or rewind. 

The first step in an iMovie HD editing 
project usually involves importing video 
that you’ve shot. If you’re using a miniDV 
or HDV camera, you can connect the cam-
era to your Mac’s FireWire jack and use 
iMovie HD’s camera mode to bring in 
your video. (If you’re using a different kind 
of camera, your import procedure will be a 
bit different; see page 262).

With camera mode, you can control 
your camera using the transport buttons in 
iMovie HD’s window. There’s no need to 
grope for the tiny buttons on your camera 
when you need to rewind, fast-forward, 
stop, or play. Click the on-screen transport 
buttons, and iMovie HD sends the appro-
priate signals to your camera through the 
FireWire cable. Video professionals call 
this device control.

The first step in editing a movie may be 
importing video, but another step should 
come first: making sure you have enough 
free disk space. Digital video eats disk 
space like I eat Oreos: for miniDV video, 
you’ll need about 200MB of free space for 
each minute of video. For HDV video, 
you’ll need a few times that amount. 
Planning to use titles, transitions, and 
effects? They take up space, too. Bottom 
line: think about buying an external hard 
drive and using it for your video endeavors.

Importing DV and HDV Video
Importing from a 
FireWire Camera
Step 1. Connect your DV or HDV 
camera to your Mac’s FireWire jack. 

Step 2. Be sure the 
camera is turned on and 
in its VCR mode (called 
VTR on some cameras).

Tip: To store imported video on an external 
hard drive, simply create your project on the 
external drive. If you’ve already started the 
project and it’s on your internal drive, quit 
iMovie HD, copy the project to the external 
drive, then open that copy.

Step 3. To start and stop 
importing, click Import or 
press the spacebar while 
the tape is playing back.

When iMovie HD is in 
camera mode, the play-
back buttons control  
your camera.

HD Differences
    Importing from an HDV 

camera? With slower 
Macs, you’ll experience an odd 
delay as the video comes in: the 
tape may finish playing, but you’ll 
still see video being displayed in 
iMovie HD’s monitor area. The vid-
eo’s motion may also appear jerky.

This occurs because your Mac 
must transcode (convert) the HD 
video into a format that allows for 
fast editing. On the fastest, dual-
processor G5 Power Macs and 

Intel-based Macs, this process 
occurs more or less in real time; 
not so on slower Macs.

One ramification: it’s a bit harder to 
tell when to stop importing, since 
your Mac may be displaying foot-
age that the camera actually played 
back seconds or minutes earlier.

To selectively import HDV footage 
to a slower Mac, view the footage 
on your camera’s LCD screen  
during the import, and use your 
camera’s buttons to stop and  
start playback.
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Trimming is the opposite of 

cropping. When you crop, you 

use the crop markers to indicate 

which portion of a clip you want 

to keep. When you trim, you use 

the crop markers to indicate 

what you want to delete. Drag 

the crop markers left and right 

to mark the footage that you 

want to toss to the cutting room 

floor. Then, press your key-

board’s Delete key or choose 

Clear from the Edit menu.

It’s best to use trimming to 

remove footage from the very 

beginning or very end of a clip.  

If you delete footage from the 

middle of a video clip, you’ll end 

up with an awkward, visually jar-

ring jump in the action. This kind 

of sloppy splice is called a jump 

cut, and it’s often a sign of 

shoddy movie-making.

Then again, one director’s flaw 

might be another’s effect. Jump 

cuts are common special effects 

in music videos and other “arty” 

productions.

To avoid a jump cut, put a cut-

away or reaction shot at the 

point where the jump cut would 

be (see page 234). If you don’t 

have a cutaway or reaction shot, 

put a three- to five-frame cross-

dissolve transition at the jump 

cut point. This is called a soft 

cut, and it’s common in docu-

mentaries and newscasts.

By the way, don’t confuse this 

form of trimming with the direct 

trimming feature described on 

page 230. Direct trimming 

involves changing the start or 

end point of a clip by dragging 

its edges in the timeline.

Trimming Clips (and the Pros and Cons of Jump Cuts)

Trashing Footage

Chances are your Clips pane will contain 
clips that you don’t end up using. To 
reclaim disk space, discard those clips: 
select them and press the Delete key, or 
drag the clips to the Trash in the lower-
right corner of the iMovie HD window.

When you crop a clip, iMovie HD doesn’t 
actually discard any footage. That’s great 
in that it lets you reclaim cropped footage 
as described at right.

But what if you want to free up disk 
space by deleting footage you know you 
won’t be using? Unlike with previous ver-
sions, you’re out of luck in iMovie HD 6. 
Even if you split a clip, throw away one 
half, and empty the trash, that deleted 
footage still exists. The upside is that you 
won’t accidentally delete footage you 

might want later; the downside is that 
you’re using more hard disk space. 

For details on managing iMovie HD’s 
Trash, see page 233.

Reclaiming the Past

You’re working on your movie and realize 
that a shot you cropped really needs to be 
longer after all. To restore the cropped 
footage, select the clip, then choose Revert 
Clip to Original from the Advanced menu.

The Keys to Precision

To fine-tune a crop marker’s position, 
select the crop marker and press the key-
board’s left and right arrow keys to move 
the marker in one-frame increments. To 
move in 10-frame increments, press Shift 
along with the arrow key. These keyboard 
controls work throughout iMovie HD.

Controlling What Plays

You already know that clicking the play 
button or pressing the spacebar begins 
playback. You may have noticed that 
what iMovie HD plays back depends on 
what is selected.

You can choose to play just one item— 
a clip, a title, a transition, and so on— 
by selecting that item, then clicking on the 
play button or pressing the spacebar. This 
can be a handy way to check out a title or 
transition you’ve just added. To play back a 
portion of your project, select those items 
by Shift-clicking, then start playback.

To play an entire project, press your key-
board’s Home key, then press the space bar.

After you import video and other assets, 
the real work (and fun) of building your 
movie begins.

All building projects require advance 
preparation, and video editing is no excep-
tion. You might begin by renaming your 
clips to give them descriptive names. You 
don’t have to rename clips, but doing so can 
make them easier to sort out and manage.

Next, you might crop a clip to remove 
footage you don’t want. iMovie HD defines 
cropping differently than imaging programs, 
such as iPhoto. When you crop a clip in 
iMovie HD, you change its length, not its 
dimensions—you remove seconds or min-
utes, not pixels. After cropping a clip, you 
might add it to the movie by dragging it to 
the timeline at the bottom of the screen.

As you perform these tasks, you’ll often 
work with iMovie HD’s playhead, moving 
it to the start of a clip, or dragging it back 
and forth—a process called scrubbing—to 
find the portion you want to retain.

Naming and cropping—these are the 
chores that prepare clips for their screen 
debut. And that debut occurs when you 
drag the clips to the timeline.

Working with Clips

As you adjust the crop markers, the 
bottom of the iMovie HD window 
(not shown here) tells you how long 
the cropped clip will be.

Step 2. Click just 
below the monitor, 
then drag the trian-
gular crop markers 
left and right to 
mark the footage 
you want to keep. 
To review your 
selection, drag the 
playhead left and 
right.

Rename Your Clips 

iMovie HD automatically names imported clips, giving them 
names, such as Clip 01 and Clip 02, that aren’t exactly 
descriptive. Give your clips descriptive titles, such as Bird 
Close-up or Beach Long Shot, to help you identify them.  
To rename a clip in the Clips pane, simply click its name and 
type a new name. Or, double-click on a clip and type a new 
name in the Clip Info dialog box. You can also rename clips in 
the clip viewer (described on page 231).

Cropping Clips

Any clip you import may have extraneous junk at its beginning 
and end. By cropping the clip to remove this excess, you can 
prepare the clip for its screen debut. 

Tip: If you’re planning to add a transition before or after a clip, 
make the clip a bit longer than you otherwise would.

Step 1. Select the clip you want to crop. You can also 
crop a clip that you’ve already added to the timeline.

Step 3. To perform the crop, 
choose Crop from the Edit 
menu (or press 1-K).
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You can view your project’s march of time in 
either of two ways: using the timeline viewer or 
the clip viewer. Each viewer has its strengths, and 
you’re likely to switch between them frequently as 

you work on a movie. To switch between views, 
click the clip viewer button or the timeline viewer 
button, or press 1-E. 

Timeline Versus Clip: Which Viewer to Use?

The clip viewer shows large 
thumbnail versions of each clip. 
In this viewer, you can change 
the order of clips by dragging 
them left and right. You can also 

rename clips here. However,  
this viewer does not show audio 
tracks or provide audio controls. 
The clip viewer is ideal when 
you’re first assembling a movie 

or you want to experiment with 
different clip sequences. When 
it’s time for audio fine-tuning 
and other precise work, switch 
to the timeline viewer.

The Clip Viewer: Basic Sequencing

The timeline viewer adds two 
audio tracks and a control for 
adjusting audio levels. 

Use the timeline viewer to work 
with sound and trim clips directly 
as described on the following 
pages. Unlike earlier iMovie 

versions, iMovie HD also lets you 
change the order of clips in the 
timeline viewer.

The Timeline Viewer: Audio, Trimming, and More

Timeline Techniques:  
Adding Clips to a Movie
A clip in the Clips pane is like a baseball player on the bench. To put the clip 
on the playing field, you must add it to the timeline.

Select the clip, then 
drag it to the timeline.

Other Ways to Add Clips

Usually, you work with one clip at a time,  
dragging it to the timeline after you’ve cropped 
it as described on the previous pages. But 
there’s more than one way to work with clips.

Drag several at once. You can add multiple 
clips to the timeline at once. Select each clip 
by Shift-clicking on it, then drag the clips to 
the timeline as a group. You can also select 
multiple clips by dragging a selection rectan-
gle around them; click the narrow gray border 
between clips to begin drawing the selection.

Drag from another project. If you have 
more than one iMovie HD project open, you 
can drag clips from one project to another.

Paste from the Clipboard. You can also  
add a clip to the timeline using the Paste 
command. Select a clip in the Clips pane—
or a clip that’s already in the timeline— 
and cut or copy, then paste. You can even 
paste clips from a different iMovie HD proj-
ect, although if the clips use a different 
video format, iMovie HD will have to trans-
code them when you paste. (See the sidebar 
on page 225.)

Directly from your camera. If you’ll be 
using almost all of the footage you shot— 
in the order in which you shot it—you might 
want to have iMovie HD add your clips 
directly to the timeline when you import your 
video. In the Import portion of the 
Preferences dialog box, click the Movie 
Timeline button.

Tip: Want to insert a clip between two 
clips that are already on the timeline?  
Just drag the clip between them, and the 
two existing clips separate to make room 
for the addition. (If a transition is between 
the two clips, you need to delete it first; 
see page 253.)
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Tips for Trimming

Resurrecting trimmed footage.  
Need to bring back some footage that 
you trimmed away? Just drag the edge 
of the clip again. For example, to bring 
back some footage from the end of a 
clip, drag to the right. To restore the clip 
to its pre-trimmed state, select the clip 
and choose Revert Clip to Original from 
the Advanced menu.

Recognizing trimmed clips. You can 
tell whether a clip has been trimmed by 
looking at it. A clip that has been 
trimmed has square corners.

A clip that hasn’t been trimmed has 
slightly rounded corners.

Trimming and adjacent clips. What 
happens if you trim a clip that already 
has a clip next to it? It depends.

If you lengthen a clip, the clips to its right 
move to the right, extending the total 
length of your project. Videographers call 
this a ripple edit.

What if you don’t want to change the 
position of the remaining clips? For 
example, maybe you’ve already timed 
them to music or narration, and a ripple 
edit would ruin your work. Easy: just 
press 1 while lengthening the clip.  
When you 1-drag to lengthen a clip, 
iMovie HD also trims the clip directly next  
to the clip you’re stretching, making it 
shorter. All other clips stay in place, and 
the overall length of your project stays 
the same. This is called a rolling edit.

Timeline Snapping

You’ve probably encountered snapping 
features in other Mac programs: when 
you drag one item near another, it snaps 
toward the second item as though the 
two share a magnetic attraction.

iMovie HD’s timeline-snapping feature 
brings this magnetism to your movies. Use 
the Preferences command to turn on time-
line snapping, and the playhead snaps to 
various elements as you drag: to the 
beginning and end of clips, to bookmarks, 
to chapter markers, and to silent portions 
of audio tracks (page 250).

Better still, clips themselves snap to 
these same elements as you drag them. 
And so does the mouse pointer when 
you’re using direct trimming. Timeline 
snapping pairs up beautifully with book-
marks and direct trimming.

Tip: You can temporarily activate (or 
deactivate) timeline snapping: just press 
the Shift key while dragging an element.

In a well-edited video, the cuts between 
scenes occur at exactly the right moments. 
In movies, the action cuts between two 
actors as they converse, reinforcing both 
the dialog and the drama. Every moviegoer 
has experienced this, probably without 
even thinking about it.

In music videos, scenes change in 
rhythm with a piece of music, turning the 
visuals and the soundtrack into a unified 
performance. Every MTV viewer has seen 
this, probably without even thinking about 
anything at all. (I’m kidding, kids—music 
videos are among the most tightly edited 
productions on the planet.)

In iMovie HD, several features work 
together to let you edit with precision. You 
can set bookmarks, visual guideposts that aid 
in trimming and positioning clips. You can 
trim clips directly in the timeline, much as 
you can in high-end programs, such as 
Apple’s Final Cut family. And timeline snap-
ping makes it easy to move clips to the 
desired location as you drag them to and 
within the timeline viewer.

Advanced Timeline Techniques
Setting Bookmarks

A bookmark is a virtual Post-It note that you can tack 
onto the timeline. Want to go back and refine a section 
later? Set a bookmark so you don’t lose your place.  
Want to time edits to music? Create bookmarks at each 
beat, measure, or other musical milestone.

To create a bookmark, position the playhead where you 
want the bookmark to be, then choose Add Bookmark 
from the Markers menu or press 1-B. A bookmark 
appears as a small green diamond on the timeline.

Tips: You can set a bookmark while your movie is  
playing. Press 1-B to create a bookmark without  
halting playback.

You can use the Markers menu or keyboard shortcuts  
to jump from one bookmark to the next. Press 1-[ to 
move to the previous bookmark and 1-] to move to  
the next one. 

Trimming Clips in the Timeline

With iMovie HD’s direct trimming feature, you can 
remove footage from a clip after you’ve added it to the 
timeline. Video editors often describe this process as 
changing a clip’s in point or out point.

To trim a clip, move the pointer near one end of the clip 
and then drag toward the center.

As I’ve mentioned previously, when you 

delete clips, iMovie HD moves them to its 

Trash. You can free up disk space by empty-

ing the Trash: choose Empty Trash from the 

File menu.

You can also be selective. Choose Show 

Trash from the File menu or click the Trash 

icon, and iMovie HD displays a window 

showing the contents of the Trash.

Managing the Trash What was that clip, anyway? To find out, 

select it and use the controls below the 

thumbnail image to play the clip. If you 

decide you’d rather not trash the clip 

after all, simply drag it from the Trash 

window to the Clips pane.

To delete just one clip, select it and click 

Delete Selected Clip.

To delete all the clips in the Trash, click 

Empty Trash.
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When you choose Paste Over at 

Playhead, iMovie HD uses as 

much footage from your cutaway 

clip as is needed to fill the 

region you highlighted. For 

example, if the cutaway clip is 

five seconds long and you high-

lighted a three-second region 

with the crop markers, iMovie 

HD uses the first three seconds 

of the cutaway clip.

On the other hand, if the cut-

away clip isn’t long enough— 

if you highlight five seconds but 

your cutaway clip is only three 

seconds long—you’ll have a gap 

in the timeline. If there’s suffi-

cient footage in the cutaway clip, 

you can extend the clip to fill the 

gap by dragging its right edge.

(The one exception to the previ-

ous paragraph occurs if your 

cutaway clip is a still image.  

In this case, iMovie HD simply 

extends the length of the still 

image to fill the region you  

highlighted.)

Whew. Got all that? It’s  

actually easier than it sounds. 

Experiment with some spare 

footage, and you’ll be doing  

cutaways in no time.

Cutaway Notes and Tips

Step 5. Mark the Footage 
You Want to Replace.

With your primary footage in the timeline, 
navigate to the spot where you want the 
cutaway to begin (tip: a bookmark can be 
a handy way to indicate where you plan 
to insert a cutaway). Select the clip in the 
timeline, then drag crop markers to indi-
cate the area you want to replace.

 
As you drag the crop markers, iMovie 
HD highlights the region that will be 
replaced by the cutaway. The cutaway 
will be inserted where the yellow bar 
starts, and it will end where the yellow 
bar ends. iMovie also indi-
cates how long the cut-
away will be.

iMovie HD mutes the 
audio of the cutaway 
clip so you don’t hear it.

iMovie HD extracts the 
audio from the primary 
clip and puts it in Audio 
Track 1.

iMovie HD pastes the 
cutaway footage into 
the timeline, beginning 
at the location of the 
first crop marker.

The pushpin icons indicate the audio 
is locked to the video above it. If you 
move the video, the audio moves 
along with it, maintaining synchroni-
zation between sound and picture.

Step 6. Insert the Cutaway.

Choose Paste Over at Playhead from  
the Advanced menu (Shift-1-V).

A cutaway is a common video-production 
technique. Think of Barbara Walters 
nodding solemnly while Fabio describes 
what kind of tree he’d like to be. Or 
maybe the video changes to show a 
close-up of Grandma’s garden as she 
talks about it. To create edits like these, 
use the Advanced menu’s Paste Over at 
Playhead command.

Try it yourself. Want to experiment  
with cutaways? Go to www.macilife.
com/imovie and download the Cutaway 
Example Footage archive. Double-click 
the archive after downloading it, then 
open the folder named Cutaway Footage 
and read the instructions inside.

Step 1. Get Your Shots
Begin planning cutaway shots when 
shooting your video. After Grandma 
talks about her garden, shoot some 
close-ups of the plants she talked 
about. While you’re shooting the school 
play, grab a couple of shots of the audi-
ence laughing or clapping. Or after 
you’ve shot an interview, move the cam-
era to shoot a few seconds of the inter-
viewer nodding. (In TV news, this kind 
of shot is called a noddie.)

Tip: Still have an old VHS or 8mm 
camcorder? Dust it off, pop it on a tri-
pod, and use it to shoot short cutaway 
shots. Dub the footage to your miniDV 
camcorder, then import it into iMovie 
HD. The video quality won’t match 
exactly, but your viewers may never 
notice. And your cutaways will be 
authentic rather than staged.

Step 2. Set Up for the Edit
With your footage imported, you’re ready 
to set up for the edit. With cutaway 
shots, you retain the audio from the  
primary clip and discard the audio from 
the cutaway shot. iMovie HD does this 
for you: choose Preferences from the 
iMovie HD menu, click the General but-
ton, and be sure the Extract Audio 
When Using “Paste Over at Playhead” 
box is checked.

Step 3. Crop the Cutaway.

Using the crop markers as described on 
page 228, crop the cutaway footage so 
that it begins at the first frame you want 
to use as the cutaway. Don’t bother 
specifying the exact end of the cutaway 
at this point—you’ll do that in Step 5.

Step 4. Copy the Cutaway.

In the Clips pane, select the cutaway and 
choose Copy from the Edit menu (1-C).

Another way to cutaway. For those 
times when you want precise control 
over the contents of the cutaway clip, 
use a different technique to insert the 
cutaway. In Step 3, crop the cutaway clip 
to the exact length you want it to be. 
Copy the cropped clip to the Clipboard, 
then position the playhead at the spot 
where you want to insert it—don’t high-
light an area with the crop markers.  
Now choose Paste Over at Playhead. 
iMovie HD pastes the entire cutaway clip, 
replacing an equal amount of footage  
in the timeline.

Creating Cutaways

Make sure your  
primary and cut-
away footage exist 
as separate clips.
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Play or pause  
the preview.

Loop the preview  
playback.

Specify the desired start 
and end zoom settings by 
dragging the slider or by 
typing in the box. To 
change the starting zoom 
setting, click Start before 
adjusting the zoom set-
ting. Similarly, to change 
the ending zoom setting, 
first click End.

iMovie HD applies 
the settings and 
adds the photo or 
photos to the 
timeline.

Reverses your settings—
for example, turns a zoom 
in into a zoom out.

To specify the length of 
time you want the image 
to appear, drag the slider 
or type in the box.  
(Values are in seconds 
and frames. For example, 
for a 51⁄2 second duration, 
type 5:15.)

Note: The Ken Burns 
effect is sticky. That is, 
iMovie HD remembers  
the last set of pan and 
zoom settings that you 
used and applies them  
to future photos.

 
 
 
 
When zoomed in on a 
photo, drag the photo 
using the hand pointer to 
specify which part of it 
you want to see.

To pan-zoom a photo,  
you must specify the start 
and finish settings for the 
move: that is, how you 
want the photo to look 
when it first appears,  
and how you want it to 
look at the end of its 
duration.

Preview scrubber bar; 
drag the diamond left and 
right to “scrub” through 
the preview.

Cancel and hide the  
Photo Settings panel.

Apply the  
settings. 

Step 3. 
In the Photo Settings panel, adjust the duration and zoom settings, then click .

Photo Tips

Photos from elsewhere. You can also 
use photos that aren’t stored in your 
iPhoto library. Click the Clips button, 
then drag the photos into the Clips 
pane. You can also import photos using 
the Import command in the File menu. 
You can even drag a photo’s icon 
directly to the timeline. 

When you import a photo using any of 
these techniques, iMovie HD applies the  
current Ken Burns effect settings to the 
photo. To change those settings, see 
the next page. Alternatively, if you know 
what Ken Burns settings you want, you 
can set them up first and then import 
the photo.

Trimming photo clips. If you’ve 
applied the Ken Burns effect to a photo, 
you can trim its duration in the timeline, 
but you can’t extend it. If you haven’t 
applied Ken Burns, you can trim and 
extend a photo’s duration. If you antici-
pate making significant changes to a 
photo’s duration as you work, wait to 
apply the Ken Burns effect until after 
you’ve laid out your clips in the timeline.

Cropping a photo. Want to show just 
part of a photo, with no motion? Be 
sure that the Ken Burns Effect box is 
checked, then select a photo in the 
Photos pane. Click Start and use the 
pan and zoom controls to crop the 
photo. Next, press the Option key and 
click End. (Pressing Option tells iMovie 
HD to copy the Start settings to the End 
settings.) Specify a duration for the clip, 
then click Apply.

Adding a Photo from  
Your iPhoto Library

Step 1. 
Click the Media button, and then the Photos button.

Step 2. 
Select the photo. You can select  
multiple photos by Shift-clicking  
or 1-clicking on them.

Photographs are mainstays of many types 
of movies, especially montages and docu-
mentaries. With the photo browser in 
iMovie HD, you can add photos from your 
iPhoto library to your movies. You can  
also add photos that aren’t stored in your 
iPhoto library by dragging them into 
iMovie HD or by using the File menu’s 
Import command.

When adding photos to movies, 
consider taking advantage of iMovie HD’s 
Ken Burns effect to add a sense of dyna-
mism to your stills. Why name a feature 
after a filmmaker? Think about Ken Burns’ 
documentaries and how his camera appears 
to move across still images. For example, a 
shot might begin with a close-up of a 
weary face and then zoom out to reveal a 
Civil War battlefield scene.

That’s the Ken Burns effect. Now, Ken 
Burns himself would probably call it by its 
traditional filmmaking terms: pan and scan 
or pan and zoom. These terms reflect the 
fact that you can have two different kinds 
of motion: panning (moving across an 
image) and zooming (moving in or out).

Whatever the effect’s name, its result is 
the same: it adds motion and life to other-
wise static images.

Adding Photos to Movies

To view a specific 
album, choose its 
name from the list.
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iMovie HD’s support for multiple video 
formats introduces some special Ken 
Burns considerations.

4:3 formats. Working in the standard 
DV, iSight, or MPEG-4 formats? If you 
plan to show a photo at actual size  
(that is, a zoom setting of 1.00), be 
sure your photos’ proportions match 
the 4:3 aspect ratio of these formats. 
Otherwise, the photos won’t completely 
fill the video frame: they will have  
black borders.

Most digital camera photos have a 4:3 
aspect ratio. If the photos you want to 
use don’t have these proportions, you 
have two options. The easiest option is 
to simply use the Ken Burns zoom slider 
to zoom in just enough that the photos 
fill the Ken Burns preview box.

The more dramatic option is to crop 
your photos in iPhoto. From the 
Constrain pop-up menu in iPhoto’s edit 
view, choose 4 x 3 (DVD). Remember, 
cropping alters the photo in your library 
and anywhere else it appears. If you 
want an uncropped (or differently 
cropped) version of a photo, duplicate 
the photo before cropping it.

  HD format. Photos can look 
beautiful in high-definition format, but 
in their original form, they will definitely 
not fill the video frame. Instead, they’ll 
appear pillarboxed, with fat black bor-
ders on their left and right edges.

 

 
To avoid pillarboxing, specify a Ken 
Burns zoom setting of 1.36.

 

 
If you’d prefer to give iMovie HD cropped 
photos, use iPhoto’s Constrain pop-up 
menu to specify a custom crop propor-
tion of 16 x 9 (HD).

DV Widescreen format. This 16:9 for-
mat will also pillarbox a standard digital 
camera photo. To zoom in just enough 
to hide the black borders, specify a Ken 
Burns zoom setting of about 1.36 or 1.40.

For a more drastic fix, crop the photo  
in iPhoto. You can use the Constrain 
pop-up menu’s 16 x 19 (HD) option, 
but you may find the resulting photo 
still has a thin black border. If that’s the 
case, revert to the original version of 
the photo and crop again, this time 
specifying a custom crop proportion of 
1.818 x 1. It sounds weird, but it works.

Changing Settings

You’ve applied the Ken Burns effect 
and now decide that you want to 
change the clip’s pan, zoom, or dura-
tion settings. Select the clip in the 
timeline, click the Media button, then 
click the Photos button. Now make  
the desired adjustments in the Photo 
Settings pane and click Update.

Tip: As an alternative to navigating to 
the Media pane, you can also Control-
click on the clip in the timeline and 
choose Edit Photo Settings from the 
shortcut menu.

Note: If there’s a transition on either 
side of the clip, iMovie HD will need to 
recreate it, since it contains frames 
that will no longer match the new clip. 
iMovie HD displays a message warning 
you that the transition will have to be 
“re-rendered.”

Image Resolution  
and Zooming

iMovie HD imports photos at their  
full resolution. This lets you zoom in  
on part of a photo and still retain 
image sharpness.

However, if you zoom in on a low- 
resolution image or one that you’ve 
cropped heavily in iPhoto, you will 
probably notice some chunky-looking 
pixelation. So think twice about zoom-
ing in on low-resolution images unless 
you want that pixelated look.

  If you’re working in a high-defi-
nition format, you may find that you 
can’t zoom in very far on photos that 
have relatively low resolution (for 
example, two megapixels), at least not 
without seeing ugly visual artifacts.

Searching for Titles

The Photos pane in iMovie HD contains 
a search box, but it isn’t as versatile as 
its counterpart in iPhoto. You can 
search for text present in a photo’s title 
only. You can’t search for text present 
in comments, roll names, file names, 
or keywords.

Zoom to Tell a Story

Creative use of zooming can help tell 
your story. When you zoom in, you 
gradually focus the viewer’s attention 
on one portion of the scene. You  

tell the viewer, “Now that you have the 
big picture, this is what you should pay 
attention to.”

When you zoom out, you reveal addi-
tional details about the scene, increas-
ing the viewer’s sense of context. You 
tell the viewer, “Now that you’ve seen 
that, look at these other things to learn 
how they relate to each other.”

Go Slow

Unless you’re after a special effect, 
avoid very fast pans and zooms. It’s 
better to pan and zoom slowly to allow 
your viewers to absorb the changes in 
the scene.

Generally, a zoom speed of 0.05 to 0.1 
per second gives a pleasing result. For 
example, a five-second clip should 
have a difference between start and 
finish zoom of about 0.5.

Vary Your Zoom 
Direction

Variety is the spice of zooming. If 
you’re creating a photo montage and 
zooming each image, consider alternat-
ing between zooming in and zooming 
out. For example, zoom in on one 
image, then zoom out on the next.

A fine example of this technique lives 
elsewhere within iLife: iPhoto’s auto-
matic Ken Burns effect alternates 

between zooming in and zooming out. 
So does the screen saver in Mac OS X.

Tip: iMovie HD provides a shortcut 
that makes it easy to obtain this vari-
ety. Select more than one photo in the 
Photos pane, specify Ken Burns set-
tings, and then press the Option key 
while clicking the Apply button. iMovie 
HD adds the photos to the timeline 
and alternates between zooming in 
and zooming out.

The Need to Render

When you apply the Ken Burns effect, 
iMovie HD must create the video 
frames that represent your efforts. This 
is called rendering, and is described in 
more detail on page 253.

You can continue to work in iMovie HD 
while a clip is rendering, but you may 
notice that the program’s performance 
is a bit slower.

Working with the Ken Burns Effect
Video Formats and Photo Proportions

To always  
have iMovie HD  
re-render transi-
tions, check  
this box.

To re-render  
adjacent transi-
tions, click OK.

To cancel the new 
Ken Burns settings 
and keep the old 
clips, click Cancel.
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Step 1.
Set up the first Ken Burns 
move as desired and then 
apply it.

Step 2.
In the photo browser, select 
a different photo, and then 
select the same photo that 
you selected for Step 1. 

This tricks iMovie HD into 
preparing to create a new 
clip instead of updating the 
one you just created.

Step 3. 
In the Photo Settings panel, 
click the Reverse button.

This reverses the Ken Burns 
settings that you set up for 
Step 1: its end point becomes 
the new start point.

Step 4.
Specify the End settings for 
the second Ken Burns move 
and then apply it.

Beyond Ken Burns: Other Pan-Zoom Tools
Ken Burns isn’t the only game  

in town. Several companies  

offer pan-zoom tools that work 

with iMovie HD.

Photo to Movie. Photo to Movie 

by LQ Graphics (www.lqgraphics.

com) makes it very easy to cre-

ate pan-zoom effects. Create 

your effect in Photo to Movie, 

export it as a QuickTime movie, 

and then bring it into iMovie HD 

and add it to your project.

Photo to Movie’s results are 

superior to those created by the 

Ken Burns effect. Photo to Movie 

does a better job of what anima-

tors call ease in and ease out : 

rather than motion abruptly 

starting and ending, the motion 

starts and ends gradually. The 

results have a more profes-

sional appearance. 

SlickMotion. This simple pro-

gram is included with GeeThree’s 

Slick Transitions and Effects 

Volume 4, an extensive library of 

iMovie effects. SlickMotion also 

supports ease-in/ease-out, and 

adds the ability to rotate images.

Motion Pictures. This scaled-

down version of Photo to Movie 

is included with Roxio’s Toast.

Advanced Ken Burns Techniques
Ken Burns has some limitations. One is 
that you can’t “hold” on a certain frame. 
You might want to have a 10-second clip in 
which the photo zooms for the first eight 
seconds and then remains static for the last 
two. Or maybe you want to zoom in part 
way, freeze for a couple of seconds, and 
then continue zooming.

Ken can’t do that.

Another limitation is that you can’t 
combine multiple moves in a single clip. 
For example, you might want to pan across 
a photo and then zoom in on part of it. 

Ken can’t do that, either.

At least not without a little finessing. 
It’s actually possible to accomplish both of 
these tasks in iMovie HD. Here’s how.

Holding on a Frame
To hold on a frame, save a frame from a Ken Burns- 
generated clip, then add it to the timeline.

Step 1. 
Set up the Ken Burns effect as desired and then  
apply it, as described on page 237.

Step 2. 
Select the clip that iMovie HD has rendered, then 
move the playhead to its last frame.

Step 3. 
Choose Create Still Frame from the Edit menu  
(Shift-1-S).

Step 4.
Locate the still frame in the Clips pane, drag it to the 
timeline and, if necessary, trim it to the desired length.

Tip: You can also adjust the still frame’s duration by 
double-clicking the clip, then entering a new duration  
in the Clip Info dialog box.

You can also start by holding on a 
frame, and then panning and zoom-
ing. First, apply the Ken Burns effect, 
then navigate to the first frame of the 
resulting clip and create a still frame 
from it. Position the still-frame clip 
before the Ken Burns clip.

Another variation involves inserting  
a still image in the middle of a Ken 
Burns move so that panning and 
zooming stops and then resumes. 

For this trick, apply the Ken Burns 
effect and then split the resulting clip 
where you want to hold on a frame. 
(To split a clip, position the playhead 

at the desired split point and choose 
Split Video Clip at Playhead from the 
Edit menu.)

Next, move the playhead to the last 
frame of the first half of the clip (or 
to the first frame of the second half). 
Create a still frame, and drag the 
resulting clip between the two halves.
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Step 4. 
Locate the song you want to import.

You can choose a specific 
playlist from the list of 
sources.

You can sort the list of songs 
by clicking on a column head-
ing. Drag columns left and 
right to move them. Resize 
columns by dragging the  
vertical line between their 
headings.

Use the Search box to quickly 
locate a song based on its 
name or its artist’s name.

To play a song, select it and 
click this button, or simply  
double-click the song’s name. 

Step 5. 
Click the Place at Playhead button.

iMovie HD adds the music to the  
timeline’s second audio track.

Tip: As an alternative to clicking  
Place at Playhead, you can also  
click and drag a song to any  
location on the timeline.

Use the media browser to bring in music from your  
iTunes library or GarageBand.

Step 1. 
Position the playhead where you  
want the music to begin playing.

Step 2. 
Click the Media button and then the  
Audio button.

Step 3. 
Select iTunes or GarageBand in the  
list of audio sources.

Note: In order to be able to preview a GarageBand  
project in the media pane, or add the song to the  
iMovie timeline the project needs to be saved with an 
iLife preview.

For details, see page 347.

Importing Music from Your  
iTunes Library or GarageBand

Adding Audio to Movies
In movie making, sound is at least as 
important as the picture. An audience will 
forgive hand-held camera shots and poor 
lighting—The Blair Witch Project proved 
that. But give them a noisy, inaudible 
soundtrack, and they’ll run for the aspirin.

Poor quality audio is a common flaw of 
home video and amateur movies. One prob-
lem is that most camcorders don’t have very 
good microphones—their built-in mikes are 
often located on the top of the camera 
where they pick up sound from the camera’s 
motors. What’s more, the microphone is 
usually far from the subject, resulting in too 
much background noise. And if you’re 
shooting outdoors on a windy day, your 
scenes end up sounding like an outtake 
from Twister.

If your camcorder provides a jack for  
an external microphone, you can get much 
better sound by using one. On the follow-
ing pages, you’ll find some advice on 
choosing and using microphones.

If you’ve already shot your video or you 
can’t use an external mike, there is another 
solution: don’t use the audio you recorded. 
Instead, create an audio bed consisting of 
music and, if appropriate, narration or 
sound effects (see page 245).

iMovie HD provides several features that 
you can use to sweeten your soundtracks. 
Take advantage of them. And if they don’t 
do the job, consider bringing your movie 
into GarageBand for additional sonic sea-
soning (page 362).
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Recording an 
Audio Narration
If you connect a microphone to your  
Mac, you can record narration directly 
within iMovie HD.

To begin recording, click the red button 
 next to the volume meter in iMovie 

HD’s Audio pane. To stop recording, click 
the red button again.

As you record, iMovie HD adds your nar-
ration to the first audio track, positioning it 
at the playhead’s location and giving it the 
name Voice 01.

Tip: For the best sound, you want to 
record loud, but not too loud. At its loud-
est, your voice should illuminate the yellow 
portion of iMovie HD’s volume meter. If 
you illuminate the red portions, your 
sound will be distorted.

 Good

 Bad

Also, position the mike carefully to avoid 
the “popping p” syndrome—bursts of 
breath noise. Record the phrase “pretty 
poppies” as a test, and back off if the 
results sound like a hurricane. (Audio 
trivia: those breathy, percussive conso-
nants are aptly called plosives.)

iM
ovie HD

: M
aking M

ovies
Adding Audio to M

ovies
iMovie HD: Making Movies

242 243



But if the mike is too close, stereo sepa-
ration is exaggerated—some sounds 
come only from the left speaker, others 
only from the right, and sounds in the 
center are louder than they should be. 
Move the mike too far away, and you get 
a muddy-sounding recording with too 
much room reverb.

When recording a live performance,  
try to show up for rehearsals so that  
you have time to experiment with differ-
ent mike distances. If your camera has  
a headphone jack, connect a good pair  
of headphones—ones whose cups sur-
round your ears and thus block out  
external sounds. Record a test, play it 
back, and listen.

For recording narrations, consider 
assembling a makeshift sound booth  
that will absorb room echo and block 
computer and hard drive noise. Glue 
some sound-absorbing acoustical foam 
onto two sheets of plywood or foamcore.  
(See www.soundsuckers.com for a wide 
selection.) Position the two sheets in 
front of you in a V shape, with the mike 
at the narrow end. If you’re on a tight 
budget, use blankets, pillows, carpet 
remnants, or even a coat closet. The  
idea is to surround yourself, and the 
mike, with sound-absorbing material.

Another major microphone manufacturer, 
Shure, has published some excellent 
mike-placement tutorials. Download them 
at www.shure.com/booklets.

Creating an Audio Bed

If you weren’t able to get good audio 
when you originally shot your video, con-
sider muting your video’s audio track and 
just putting a music bed behind your 
shots. Create a montage of shots, using 
bookmarks and direct trimming to help 
you time your edits to the music.

And finally, a related tip: If you’re shoot-
ing scenes where the audio is mostly 
ambient sound—the waves at the beach, 
the din of a party—shoot a few minutes 

of uninterrupted video, keeping the cam-
era stationary. After importing the video, 
delete the video track and keep the 
audio. (In iMovie HD, drag the video clip 
to the timeline, then choose Extract 
Audio from the Advanced menu.) Now 
you have an audio bed upon which you 
can put a series of video shots. After you 
add those shots, mute their audio. This 
technique eliminates jarring sound 
changes between shots.

A Field Guide to Mike Placement

Scenario Ideal Mike Position

Solo piano About a foot from the center of the  
piano’s harp, pointed at the strings  
(open the piano’s recital lid). 

Wedding ceremony As close to the lovebirds as possible.  
Many wedding videographers attach a 
wireless lavaliere mike to the groom or  
the officiator. (Bridal gowns tend to rustle 
too much.) A mike hidden in a flower 
arrangement may also work.

Narrator 6 to 9 inches from the speaker’s mouth, 
angled downward. To avoid plosive 
problems, use a windscreen and position 
the mike just off to the side, pointing at  
the mouth. Alternative: a lavaliere mike.

Choral group 1 to 3 feet above and 2 to 4 feet in front  
of the first row of the choir.

Birthday party around a table On an extended floor stand, angled 
downward. Alternative: on a tabletop desk 
stand, pointing at the birthday kid.

Tips for Recording Better Sound
Upgrade Your Microphone

To get better sound, get a high-quality 
external microphone and place it close to 
your subject.

Before you buy an external mike, deter-
mine whether your camcorder can accept 
one. Some inexpensive camcorders don’t 
provide a jack for an external mike;  
others may require an adapter that con-
nects to the bottom of the camera. Most 
mid-range and all high-end camcorders 
have external mike jacks. On most cam-
eras, it’s a 1⁄8-inch stereo minijack.

Clip-on. Microphones come in all sizes 
and designs. Some are specialized—for 
example, a lavaliere mike, which clips to 
a lapel or shirt, is great for recording a 
single voice, such as that of a teacher  
(or TV host). But a lav mike is unsuitable 
for recording a musical performance.

Shotgun approach. When you can’t get 
the mike close to your subject but still 
want to reduce extraneous noise, con-
sider a shotgun mike. In a shotgun mike, 
the microphone capsule is mounted 
within a long barrel designed to reject 
sound coming from the side of the mike. 
Shotgun mikes are popular in TV news 
and movie making. They’re sensitive 
enough to be located out of the video 
frame, and their highly directional sensi-
tivity means they won’t pick up noise 
from cameras and crew members.

A shotgun mike works best when mounted 
on a boom, a long pole (often hand-held) 

that allows the mike to point down at the 
subject. When you see a video crew with 
one person who appears to be holding a 
fishing pole with a long tube on the end of 
it, you’re seeing a shotgun mike (and a 
sound technician) in action.

Two in one. The most versatile mike  
you can buy is a single-point stereo mike. 
A stereo mike crams two microphone 
capsules into a single package. Each 
capsule is precisely positioned relative  
to its companion, thus eliminating one of 
the biggest challenges of stereo record-
ing: getting accurate balance and sepa-
ration between the left and right channels. 
I use the AT822 from Audio-Technica 
(www.audio-technica.com). 

With high-quality extension cables, the 
mike and camera can be up to about 
25 feet apart. At greater distances, you 
risk losing some high frequencies and 
picking up hum and other electrical noise.

A balanced alternative. When you need 
to run cables longer than 25 feet or 
so—or when you want the best possible 
quality and are prepared to pay for it—
consider a balanced mike. All of the 

aforementioned mikes are available in  
balanced and unbalanced versions.  
A balanced mike is wired in a way that 
reduces electrical noise and allows for 
cable runs of up to 100 feet or so. 
Balanced mikes cost more than unbal-
anced ones, but professionals and  
serious amateurs prefer balanced mikes 
due to their resistance to electrical noise 
and their support for longer cable runs.

A balanced mike typically uses an XLR 
connector, and only high-end camcorders 
have XLR jacks. But there is a way to  
connect a balanced mike to an unbal-
anced miniplug jack: the DXA-2 adaptor 
from BeachTek (www.beachtek.com).  
A compact metal box that attaches to  
your camera’s tripod mount, the DXA-2 
requires no external power supply  
and has built-in knobs for adjusting  
volume levels.

Placement is Everything

To do justice to any mike, position it 
properly. For that school play or recital, 
use a mike stand and position the mike 
high, pointing down toward the stage at 
about a 45-degree angle. If you can’t set 
up your own mike stand, just try to get 
the mike at least a few feet off the stage 
and as close to center stage as possible.

How close should the mike be? That 
depends on what you’re recording  
(see the table at right). The closer the 
mike is to a sound source, the less room 
noise and reverberation it picks up. 

spread M13
iM

ovie HD
: M

aking M
ovies

Tips for Recording Better Sound
iMovie HD: Making Movies

244 245



Adjusting Volume Over Time
Here’s how to adjust a track’s volume level to accommodate 
narration or dialog in another track. 

Step 1.
Choose Show Clip Volume Levels from  
the View menu.

When volume 
levels are visible, 
iMovie HD dis-
plays a volume 
level bar on each 
track.

Step 2.  
Click on the audio track’s volume level bar at  
the point where you want to adjust the volume.  
A volume marker appears.

Step 3. 
To lower the volume, drag the marker down.  
To increase the volume, drag the marker up.  
To move the point at which the volume changes, 
drag the marker left or right.

Here, the volume of a music track has been 
tweaked so that the music gets softer during  
a narration passage. 

To delete a marker, select it and press the  
Delete key. 

Step 4. 
When you’ve finished tweaking volume levels, 
choose Show Clip Volume Levels from the View 
menu again so that the command is unchecked.

Adjusting the volume of an audio track  
is a common task. And when you combine 
audio in any way—mixing music, sound 
effects, dialog, and background sounds—
you almost always need to adjust the rela-
tive levels of each sound to create a 
pleasing mix. 

iMovie HD provides several ways to 
work with sound levels. You can reduce the 
volume of an entire sound clip. You might 
do this if you’re mixing music with the 
sound of the surf, and don’t want the waves 
to drown out the music. 

You can also vary a track’s volume level 
over time. When combining music and  
narration, you might want the music to start 
at full volume, fade when the narrator talks, 
then return to full volume when she stops. 

The timeline viewer provides several 
controls for adjusting volume levels. Many 
of them are easier to use when you have 
iMovie HD display audio track waveforms. 
To display waveforms, choose Show Audio 
Waveforms from the View menu.

A waveform looks a bit like the pen-
manship of an earthquake seismograph. 
Back-and-forth lines indicate the intensity 
of the shaking—in this case, of the sound 
wave. Being able to see your sound instead 
of just a horizontal colored bar is a big help 
when trimming audio tracks, adjusting vol-
ume, and creating audio fades.

Adjusting the 
Volume of a Clip
To adjust the volume of an entire audio 
clip, select the clip and then drag the  
volume slider located below the timeline.

You can also type a 
value in the text box.

Fading Out or Fading In
Creating an audio fade involves working  
with volume markers in the timeline.

Step 1. 
Choose Show Clip Volume Levels from the View menu.

Step 2. 
Click the horizontal line in the audio  
track to create and adjust volume markers.

Working with Audio Tracks

To lower the volume, 
drag the marker down. 
To move the marker 
earlier or later in time, 
drag it left or right. 

To adjust the duration 
of the fade, drag the 
beginning point of the 
marker left or right.

The completed fade.

Conversely, to create 
a fade-in, drag the 
beginning point of a 
volume marker all the 
way down, then drag 
the end point up.

Can’t trim clips? Turn off levels. If iMovie HD 
isn’t letting you use direct trimming to adjust the 
in- and out-points of clips, it’s probably because 
you’re viewing clip volume levels—direct trimming 
isn’t available when levels are displayed. Be sure 
that the Show Clip Volume Levels command in the 
View menu is unchecked.
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Sound engineers go to great lengths to 
record high-quality sound during movie 
making, but what you hear when watching 
a movie is much different than what you 
would hear on the set.

A soundtrack is usually sweetened in 
several ways: speech is given a bit more 
warmth, background noise is minimized, 
and so on.

iMovie HD includes several tools for 
punching up the quality of your movie’s 
audio and sweetening the mix.

Whether you captured audio using  
a camcorder or imported it from iTunes,  
it’s all digital information—which means 
it’s malleable and ripe for improvement  
(or just experimentation). 

Note: To use audio effects, your Mac must be 
running Mac OS X 10.4 Tiger or a later version.

Applying Audio Filters and Effects

NEW spread M14a

To Add an Audio Effect
Step 1. 

Select the video or audio clip to which you want to apply an effect.

Step 2. 

Click the Editing button and then the Audio FX button.

Step 3. 

Select the effect you  
want to use and change 
its settings.

Most of the effects  
offer only one or two  
sliders that control the 
degree to which the effect 
is applied. Some, like 
Graphic EQ and Reverb, 
offer convenient presets.

Click the Preview button 
to hear how the clip will 
sound. The sound plays 
over and over until you 
turn off the preview.

Step 4. 

Click the Apply button. iMovie HD extracts the audio (if you applied 
the effect to a video clip) and renders the new version.

Tip: Pitch Changer can be great for a laugh—or for creating a big, 
booming Voice of Doom. Applied in small degrees, Pitch Changer 
can also raise or lower a person’s voice slightly to bring out depth 
or character.

Deleting an Audio Effect
Select the audio clip and press the Delete key to 
remove the effect.

Updating an Audio Effect
When you apply an audio effect, iMovie HD renders  
a new audio clip, but doesn’t delete the original clip;  
the effect acts like a layer on top of the original.  
(Video effects work the same way; see page 256.)  
The advantage of this approach is that you can “stack”  
multiple audio effects on a clip and have each effect 
interact with the layer beneath it.

Unfortunately, you can’t pick a layer and change its  
settings. You must select the audio clip and press the 
Delete key to remove the effect, and then reapply a 
new effect with new settings. And if you’ve applied 
multiple effects, you need to remove the most recent 
layers to get to the one you want.

Tip: How many audio effects have you applied? iMovie 
HD’s interface doesn’t let on, but there is a way to find 
out. Select the audio clip and choose Show Info from 
the File menu. The name of the rendered file indicates 
how many and what types of audio effects are present.

Reduce Background 
Noise
To minimize the amount of wind or road noise  
(if the footage was shot in a car, for example), apply  
the Noise Reducer audio effect. You don’t have much 
control over isolating specific sounds, but this effect  
does an adequate job of limiting white noise. 

 
Original extracted clip 

 
After applying Noise Reducer

Tip: For more information on what effects such as 
Reverb and Delay actually do, see page 341.
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Camcorder Sound 
Settings

Most miniDV camcorders provide two 
sound-recording settings: 12-bit and  
16-bit. Always record using the 16-bit 
setting. If your sound and picture syn-
chronization drift over the course of a 
long movie, it’s probably because you 
recorded using 12-bit audio.

Muting an Audio Track

You can mute an audio track entirely by 
unchecking the box to its right in the time-
line viewer. If you uncheck the box next to 
the video track, iMovie HD mutes the vid-
eo’s sound. This can be handy when 
you’re replacing the audio in a series of 
clips with an audio bed—a segment of 
background audio that will play across 
multiple clips.

Splitting Audio Clips

You can divide an audio clip into two or 
more separate clips whose position and 
volume you can adjust independently. 
First, select the audio clip you want to 
split. Next, position the playhead where 
you want to split the clip. Finally, choose 
Split Selected Audio Clip at Playhead 
from the Edit menu or press 1-T.

Sound Effects

iMovie HD’s library of built-in 

sound effects, accessed through 

the audio section of the Media 

pane, covers a lot of aural ground.

But there’s always room for 

more sound, and the Internet is 

a rich repository of it. One of 

your first stops should be 

FindSounds, a Web search 

engine that lets you locate and 

download free sound effects by 

typing keywords, such as chick-

adee. SoundHunter is another 

impressive source of free sound 

effects and provides links to 

even more audio-related sites.

Most online sound effects are 

stored as WAV or AIFF files, two 

common sound formats. To 

import a WAV or AIFF file, use 

the File menu’s Import command 

or simply drag the file directly to 

the desired location in the time-

line viewer.

Managing Sound 
Effects

If you assemble a large library of 

sound effects, you might find 

yourself needing a program to 

help you keep track of them. You 

already have such a program: 

it’s called iTunes. Simply drag 

your sound effects files into the 

iTunes window. Use the Get Info 

command to assign descriptive 

tags to them, and you can use 

iTunes’ Search box to locate 

effects in a flash. You might 

even want to create a separate 

iTunes music library to store 

your sound effects.

Music Sources

You’ll find a symphony’s worth  

of music on the Internet.  

For private, non-commercial 

projects, try Freeplay Music  

(www.freeplaymusic.com).  

You can download and use  

its music clips for, yes, free. 

For commercial projects, how-

ever, be sure to carefully read 

the company’s rate card and 

licensing requirements.

Plenty of music is also available 

from sites such as SoundDogs, 

KillerSound, and Award Winning 

Music. These sites have powerful 

search features that let you 

locate music based on keywords, 

such as acoustic or jazz.

Loopasonic is another cool 

music site. It offers hundreds of 

music loops—repeating riffs—

that you can assemble into 

unique music tracks and use in 

GarageBand (which, of course, 

you can use to compose your 

own movie music).

And for building custom-length 

music tracks, you can’t beat 

SmartSound’s Movie Maestro 

software. Movie Maestro pro-

vides an expandable library of 

songs, each of which is divided 

into blocks that the Music 

Maestro software can assemble 

to an exact length.

Sources for Sound Effects and Music

Get links to sources of sound effects and music.
www.macilife.com/imovie 

More Sound Advice
Waveform Tips

When you’ve used the View menu to  
display audio waveforms, iMovie HD’s 
timeline snapping feature snaps the play-
head to silent portions of clips (specifi-
cally, when you scroll to within three 
frames of silence).

To work with more precision when viewing 
waveforms, zoom in on the timeline. If the 
audio in a track is on the quiet side, the 
waveform may be hard to see. Solution: 
select the audio clip and press the up-
arrow key. This accentuates the spikes in 
the waveform. To make the spikes smaller, 
press the down-arrow key.

When you import an audio clip or music 
track, iMovie HD must render the track’s 
waveform—a red progress bar appears 
at the bottom of the audio track, and the 
waveform appears a bit blurry until iMovie 
HD renders it. Because this process takes 
some time, you may want to leave the 
waveform display turned off unless you 
need it for precise editing or volume 
adjustments.

Trimming Audio

You can trim the start and end of an 
audio clip using the same direct-trimming 
techniques described on page 232. As 
with video clips, you can reclaim audio 
that’s outside of a clip’s boundaries by 
resizing the clip.

Scrubbing Audio

Here’s a handy way to locate the exact 
spot to trim or split an audio clip. Zoom 
in on the timeline, then press the Option 
key while slowly dragging the iMovie HD 
playhead. Your audio plays back, but is 
slowed down. The sound even plays 
backwards when you drag the playhead 
to the left. (Beatles fans: import some 
White Album songs from your iTunes 
library and have fun.)

Extracting Audio

At times, you may want to use only the 
audio portion of a clip. For example, 
you’re making a documentary about your 
grandmother’s childhood and you’d like 
to show old photographs as she talks.

To do this, drag the video clip to the 
timeline, then select the clip and choose 
Extract Audio (1-J) from the Advanced 
menu. iMovie HD copies the audio, 
places it in Audio Track 1, and mutes the 
audio in the video clip. 

Next, select the video clip in the timeline 
and press the Delete key. The video van-
ishes but its audio lingers on, and you 
can now position still images and other 
clips in the video’s place. You can also 
drag the audio elsewhere in the timeline.

Overlapping Audio in  
the Timeline

iMovie HD may provide just two audio 
tracks, but that doesn’t mean you’re lim-
ited to two simultaneous sounds. You can 
overlap multiple audio clips in the time-
line’s audio tracks: simply drag one audio 
clip on top of another.

Repeating Sound Effects

You might want some sound effects to  
play for a long period of time. For exam-
ple, iMovie HD’s Hard Rain sound effect 
is less than 10 seconds long, but maybe 
you need 30 seconds of rain sounds for 
a particular movie.

For cases like these, simply repeat the 
sound effect by dragging it from the 
Audio pane to the timeline as many times 
as needed. You can also duplicate a 
sound by Option-dragging it in the time-
line. If the sound effect fades out (as 
Hard Rain does), overlap each copy to 
hide the fade.

You can build magnificently rich  
sound effect tracks by overlapping 
sounds. To create a thunderstorm, for 
example, drag the Thunder sound effect 
so that it overlaps Hard Rain. Add the 
Cold Wind sound while you’re at it. And 
don’t forget to use iMovie HD’s audio 
controls to fine-tune the relative levels of 
each effect.

spread M15
iM

ovie HD
: M

aking M
ovies

M
ore Sound Advice

iMovie HD: Making Movies

250 251



The preview controls 
(from left) begin play-
back of the preview, 
loop playback, cancel 
the transition, or add 
it to the timeline.

When you select  
a transition, a  
preview appears in  
the monitor.

If you’ve selected two 
or more clips in the 
timeline, you can 
apply the transition to 
all of the clips by 
clicking Add.

When you create a transition, 

title, or effect, iMovie HD must 

create the video frames that 

represent your efforts. This ren-

dering process takes time; you 

may notice iMovie HD slows 

down a bit during rendering. 

You can continue to work while 

rendering takes place. You can 

even play back your movie, 

although you may notice 

stuttering playback when iMovie 

HD reaches areas it hasn’t fin-

ished rendering.

Although you can work during 

rendering, you might want to 

avoid adding multiple transitions 

or titles in rapid-fire succession, 

as doing so can slow iMovie HD 

to a crawl. To gauge how long 

rendering will take, look at the 

transitions, titles, or effects that 

you’ve added: a little red

progress bar shows how far 

along rendering is.

Some Background on Rendering 

Visual transitions add a professional touch 
to your project. Transitions also help tell a 
story. For example, a cross-dissolve—one 
clip fading out while another fades in— 
can imply the passage of time. Imagine 
slowly dissolving from a nighttime camp-
fire scene to a campsite scene shot the fol-
lowing morning.

Similarly, iMovie HD’s Push transition, 
where one clip pushes another out of the 
frame, is a visual way of saying “mean-
while...” Imagine using this transition 
between a scene of an expectant mother in 
the delivery room and a shot of her hus-
band pacing in the waiting room, chain-
smoking nervously. (Okay, so this is an 
old-fashioned maternity movie.)

iMovie HD’s Fade In, Fade Out, and 
Cross Dissolve transitions are “desert-
island” transitions—the ones you’d want 
when stranded on an island (perhaps while 
editing an episode of Survivor). But unless 
you are stranded on an island, don’t limit 
yourself—experiment with other types of 
transitions. To preview any transition, 
select a clip in the timeline or clip viewer, 
then click the transition’s name in the 
Transitions pane.

Like effects, transitions are visual 
spice. Season your video with them, but 
don’t let them overpower the main course: 
your subject.

Adding Transitions
Creating a Transition

To add a transition between two clips,  
first click iMovie HD’s Editing button,  
and then click the Transitions button  
to display the Transitions pane.

To add the transition, 
drag it between two 
clips in the timeline  
or clip viewer.

Some transitions, such 
as Push, allow you to 
specify a direction (for 
example, to push from 
left to right or from top 
to bottom).

To change the transi-
tion’s duration, drag the 
Speed slider or type a 
value in the box.

Testing the Transition

To see the finished transition, select it 
and press the spacebar.

If you aren’t happy with the transition, 
you can delete it (press the Delete key) 
or choose Undo.

Inserting a Clip at a 
Transition

When you create a transition between 
two clips, you establish a connection 
between those clips.

If you need to insert a new clip between 
those two clips, you must first delete the 
transition: select it and press Delete. 
Now you can insert the new clip.

Updating a Transition

Change your mind about using a particu-
lar transition style? To change an existing 
transition, first select it in the clip viewer 
or timeline viewer. Make the desired 

changes, and click the Update button in 
the Transitions pane.

Applying a Transition to 
Multiple Clips

You can apply the same transition to 
multiple clips in one step: select the clips 
in the timeline, select a transition, then 
click the Add button. You can also update 
multiple transitions at once: select them 
in the timeline (1-click on them or use 
the Edit menu’s Select Similar Clips com-
mand), adjust transition settings, then 
click Update.
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Choosing Colors

To choose a color for title text, 

click the Color button in the 

Titles pane. Click on the color 

palette to choose your hue. To 

match a color that appears in a 

clip, click the magnifying glass 

icon, position the pointer over 

the color you want to pick up, 

and then click.

To create a title over a colored 

background, create a color clip as 

described on page 274, then add 

the title to the color clip.

Photoshop Titles

You can use Adobe Photoshop  

or Photoshop Elements to make 

gorgeous, full-screen titles. You 

can add photos, create color gra-

dients, shadow effects, and more.

To create a title in Photoshop, 

specify an image size appropri-

ate to your project’s video for-

mat. For DV-format projects, use 

720 by 528; for DV Widescreen, 

use 869 by 480. For iSight and 

MPEG-4 formats, use 640 by 

480. For 720p HD, use 1280 by 

720, and for 1080i HD, use 

1920 by 1080.

Next, create your title, and  

avoid putting any text in the 

outer ten percent of the screen. 

(It might get cut off when the 

title appears on a TV set.)  

And to avoid flicker, make the  

thickness of any horizontal  

lines an even number of pixels  

(for example, 2, 4, 6).

To add the title to your movie, 

simply drag the Photoshop file’s 

icon into the Clips pane or 

directly to the timeline. Photoshop 

gurus: You don’t have to flatten 

a layered file first. iMovie HD 

accepts layered PSD files. You 

can even apply the Ken Burns 

effect to the title if you like.

You can combine Photoshop  

and iMovie HD’s built-in titling to 

create titles with text superim-

posed over a moving textured 

background. Make the back-

ground graphic much larger than 

your movie’s frame size so you 

have room to pan. Import the 

background graphic and apply a 

slow pan. Superimpose a title 

over the resulting clip.

You could also extract a page 

from an iPhoto book using the 

technique on page 193 and use 

it as a title background.

Tips for Titling

When you click a title style, iMovie HD 
displays a preview in the monitor  
(not shown here).

With some title styles, you can specify 
text position and scrolling direction. 

Normally, iMovie HD superimposes the 
title text over a clip. For a simple black 
background instead, check Over Black.

To edit an existing title, select it in the 
timeline, make your changes, and 
apply the changes by clicking the 
Update button.

Type or paste the title’s text here. In 
title styles that provide multiple text 
boxes, you can jump from one box to 
the next by pressing the Tab key.

Use this slider to adjust the title’s 
duration. For some title styles, this 
slider adjusts scrolling speed.

To add the title, drag its name to the 
timeline viewer or clip viewer, or 
click the Add button.

What’s a movie without titles? Incomplete. 
Almost any movie can benefit from text  
of some kind: opening and closing credits, 
the superimposed names of people and 
places, or simply the words “The End”  
at, well, the end.

iMovie HD’s Titles pane is your ticket 
to text. You have roughly 50 title styles 
from which to choose, with customizing 
opportunities aplenty.

Many of iMovie HD’s title styles are 
animated, and it isn’t difficult to transcend 
the bounds of good taste. Use restraint 
and lean toward classic title styles, such as 
Centered and Scrolling. When you want 
something a bit flashier, consider the 
Animated Gradient style within the Clip 
to Characters category.

Regardless of the style you choose, 
you’ll get the best results with sturdy 
fonts that remain legible despite the lim-
ited resolution of television. For example, 
at small text sizes, Arial Black often 
works better than Times, which has orna-
mental serifs that can break up when 
viewed on a TV set.

You’ll also get the best-looking titles  
if you choose colors conservatively. Avoid 
highly saturated hues, especially bright  
red, which can “bloom” when viewed  
on a standard-definition TV set. High- 
definition formats are less prone to these 
problems, but since your video may  
still end up being viewed on standard- 
definition TVs, a conservative approach  
is smart.

Roll the credits.

Creating Titles
To Create a Title

Creating a title involves choosing the title style, specifying 
title settings, and then dragging the completed title to the 
timeline.

Step 1. Click the Editing button and then the Titles button 
to display the Titles pane.

Step 2. Choose the title style you want by clicking its 
name. Some title styles are grouped together in a category; 
to view them, click the triangle next to the category name.

Step 3. Specify the title settings.

See the opposite page for an overview of title settings.

Step 4. Add the title by dragging it to the timeline.

Notes: To add a title to the middle of a clip, position the 
playhead where you want the title to appear, then click the 
Add button. To superimpose title text over a specific clip, 
drag the title to the immediate left of that clip. 

Changing a Title

Need to change an existing title? In the timeline, select the 
title. Next, display the Titles pane and make your changes. 
Finally, click the Update button in the Titles pane. You can 
also Control-click on a title and choose Edit Title Settings 
from the shortcut menu.
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Effects Over Time

Effects aren’t an all-or-nothing proposi-
tion—iMovie HD can apply or remove an 
effect gradually. Apply the Black & White 
effect over time to make a clip start in 
black and white and turn into Technicolor. 
Animate the Soft Focus effect to make a 
clip start out blurry and come into focus, 
or vice versa.

To animate effects, use the Effects 
pane’s Effect In and Effect Out sliders.

 To have the effect appear over time,  
drag the Effect In slider. 

This value indicates how much time will 
elapse until the effect is fully visible.

This value shows when the effect will 
start to fade. The time is measured from 
the end of the clip—in this example, the  
effect will begin to fade 2 seconds and 
11 frames from the end of the clip.

To make an effect go away over time, 
drag the Effect Out slider.

Speed Effects

That video of Junior’s winning soccer 
game could use some slow-motion 
instant replays. iMovie HD provides them. 
Select a clip in the timeline, display  
the Effects pane, and then click on the 
Fast/Slow/Reverse effect.

Want to see that winning 
goal in reverse? Click  
Reverse Direction.

To speed up the clip, drag toward Faster. 
To slow down the clip, drag toward 
Slower. When you move the slider, iMovie 
HD previews your settings in the monitor. 
To stop the preview, click the preview’s 
Play button. To apply the effect, click the 
Apply button.

Tips

Silence the sound. Slowing or speeding 
a clip alters its audio playback, too. You’ll 
probably want to mute the clip’s audio: 
select the clip and type 0 (that’s a zero) in 
the clip volume control below the timeline. 

Slow down for smoother motion. 
Slowing down a clip can also be a nice 
way to smooth out jerky camera move-
ment. If you had too much coffee before 
shooting that flower close-up, slow the 
shot down a bit.

Layer effects. You can apply multiple 
effects to the same clip, as if they’re 
stacked on top of each other. To remove 
an effect, select the clip and press the 
Delete key, as noted at left. To remove  
all effects, choose Revert Clip to Original 
from the Advanced menu.

Effective Tips

Being selective. Another way to  
control where an effect begins and  
ends is to apply the effect to only a  
portion of a clip. To do this, select the 
clip in the timeline and then drag crop 
markers to highlight the range of foot-
age to which you want to apply the 
effect. Now specify the effect settings 
and click Apply.

Updating effects. To change a clip’s 
effects, Control-click on the clip in  
the timeline, then choose Edit Effect 
Settings from the shortcut menu.  
Make your tweaks, then click Update.

Removing effects. To remove effects 
from a clip, select the clip and press 
the Delete key.

Specifying position. Some effects, 
such as Electricity, can be positioned 
on the screen. Click in the monitor to 
set a focus point.

Special effects are the spice of the movie 
world. When used sparingly, they enhance a 
movie and add appeal. When overused, they 
can make your audience gag.

iMovie HD’s Effects pane is the gate-
way to a full spice rack of special effects. 
The Aged Film effect makes a clip look 
like old movie film, complete with scratches 
and jitter. The Lens Flare effect simulates 
the glare of bright light entering a camera’s 
lens. Fairy Dust gives you that Tinker Bell 
look, while Electricity creates faux light-
ning bolts. And the Earthquake effect cre-
ates a fast, back-and-forth blur that may 
tempt you to duck beneath a desk.

iMovie HD introduced a few new 
effects. The Edges effect creates an edgy, 
neon-colored look. The Crystallize effect 
makes a clip looks like it’s being viewed 
through a shower door, while the Edge 
Work effect creates a pen-and-ink look.

You can also apply speed effects to your 
clips. Slow a clip down to get slow motion, 
or speed it up for a chuckle.

You can apply effects to multiple clips at 
once: Shift-click to select a range of clips, 
or 1-click to select clips that aren’t next to 
each other in the timeline.

Have fun with iMovie HD’s effects. 
But remember: too much spice is worse 
than none at all.

Adding Effects
To Add an Effect

Adding an effect involves selecting one or more clips,  
specifying effect settings, then applying the effect.

Step 1. Select the clip or clips to which you want to  
apply an effect.

Step 2. Click the Editing button and then the Video FX button  
to display the Effects pane.

 

Step 3. Choose the desired effect by clicking its name.  
iMovie HD displays a preview of the effect in the monitor.

Step 4. Specify the desired  
settings for the effect. 

iMovie HD can apply or 
remove an effect over time; 
see “Effects Over Time” on 
the opposite page.

 
Each effect has its own  
controls; they appear in  
this area.

 
Step 5. To apply the effect 
to the selected clip or clips, 
click the Apply button. 
iMovie HD renders the video 
frames required to create the effect.

spread M18
iM

ovie HD
: M

aking M
ovies

Adding Effects
iMovie HD: Making Movies

256 257



NEW spread M18a

Play the preview and control 
whether the preview plays 
over and over (loops).

To view specific parts of the 
theme element, drag the motion 
playhead left or right.

Step 1. Choose a theme fam-
ily from the pop-up menu.

Step 2. Click the theme ele-
ment you want.

Hide (or show) the preview in 
the monitor.

Hide (or show) the Drop 
Zones panel.

Step 3. If the element you’ve 
chosen provides boxes for title 
text, type the text.

Watch any TV show, and you’ll see that 
video producers rely on a standard vocabu-
lary of visual building blocks—elements 
that identify major portions of the show 
and serve to tie scenes together.

A show opens with a flashy graphic 
containing text and imagery. The first seg-
ment is introduced with another graphic.  
A city scene appears, and a superimposed 
lower-third graphic identifies the scene. 
One scene completes, then a short bumper 
appears as a visual separator before the 
next scene begins. These visual seasonings 
are sprinkled throughout the rest of the 
show, and then the credits roll.

These elements of imagery are often 
called motion graphics, and for good reason. 
Instead of being static text and graphics, 
they employ slick animation that adds 
visual appeal. Words don’t just fade in and 
fade out; they glide into view, superim-
posed over elegant, moving backgrounds.

It’s the kind of eye candy we’re used to 
seeing on TV, and now you can serve it up 
in your productions with the video themes 
built into iMovie HD 6. Choose a theme, 
then customize it by adding photos or mov-
ies to its drop zones. When you’re done, 
iMovie HD renders the clip and adds it to 
the timeline.

Themes can do more than just add  
sizzle to your movies. They can also help 
you add structure: by employing themes, 
you can frame the elements of your movie 
and tell a better story.

Important: To use iMovie HD 6’s themes, you 
must be running Mac OS X 10.4.4 or a later  
version, if available.

Adding Sizzle and Structure with Themes
The Elements of a Theme
iMovie HD includes four sets of themes, and many have counter-
parts in iDVD, iPhoto, and iWeb. Each theme provides one or 
more drop zones into which you can add photos and video clips. 
Most theme elements also provide an area where you can type 
some text.

Each set of themes provides its own mix of visual elements, but 
all of the sets have some common ground. Here’s a look at that 
common ground from the perspective of the Travel theme.

Opener 
Displays a montage of photos or movies, 
culminating with a title. Use the opener to 
begin your epic. 

Chapter 
A shorter motion graphic that’s ideal for 
separating major scenes of a movie.  
Some themes provide more than one 
chapter design.

Lower Third 
True to its name, a lower third occupies 
the lower portion of the screen; it’s ideal 
for identifying the people or places in a 
shot.

Bumper 
A bumper is also ideal for separating 
scenes. In some themes, bumpers display 
imagery only, with no text. Some themes 
have multiple bumper designs.

Credits 
You know what they are. Some themes 
provide more than one credits design.

You can add theme elements 
as you work on a movie, or 
wait until after you’ve com-
pleted other editing tasks. 
Tip: If you’re using timeline 
bookmarks (page 232) to 
align clips or time them to 
music or other audio, you 
might want to add theme ele-
ments as you work to avoid 
disrupting your movie’s timing.

To add a theme element, click 
the Themes button.

Using Theme Elements

Step 4. Drag media to the 
boxes in the Drop Zones 
panel. To add photos from 
iPhoto, click the Media button 
to display the media browser.

To add a video clip, drag it 
from the Clips pane or from 
the timeline. You can also 
drag it from these locations in 
other open iMovie projects.

Tip: For best results, be sure 
that the orientation of a photo 
or video clip matches that of 
its drop zone. For example, if 
the drop zone is vertically ori-
ented, use a vertically ori-
ented photo in it. Otherwise, 
the photo or clip may appear 
strangely cropped.

To replace an item in a drop 
zone, simply drag a new item 
to the drop zone. To remove  
a drop zone’s item, select the 
drop zone and press the 
Delete key.

Step 5. Click  or the 
check mark ( ) in the Preview.

iMovie HD renders the clip 
and adds it to the timeline. 
You can work with the clip as 
you would any other video 
clip: trim it, add effects, and 
so on.
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If you know that the 
footage you want 
occupies just a  
portion of the tape, 
check this option 
and specify how 
many minutes of 
video to capture. 
The Magic iMovie 
feature also stops 
importing video 
when it encounters 
ten seconds of blank 
tape or when it 
reaches the very  
end of the tape.

Turn off this option  
if you want to start 
capturing scenes in 
the middle of your 
tape.

Your movie’s open-
ing title will contain 
this text, so keep  
it short.

Making a Magic iMovie
To make a Magic iMovie, connect and turn on your DV or HDV cam-
corder (page 226). Then put iMovie HD to work.

Step 1.

Choose Make a Magic iMovie from the File menu, and give your new 
movie project a name. If necessary, specify the desired video format 
(see page 224).

Step 2.

Specify Magic iMovie settings.

Step 3 (optional).

Specify music soundtrack settings and click OK.

To see songs from a specific playlist, choose  
the playlist’s name.

 
You can rearrange songs after you’ve added them 
by dragging them up and down.

With many movie projects, you want con-
trol over every step of the editing process: 
timing cuts to match audio, trimming 
clips with precision, and fine-tuning your 
soundtrack until everything sparkles.

But sometimes you just want fast 
results. It’s Sunday afternoon, and your vis-
iting relatives are (finally!) preparing to go 
home. You shot some video of the kids at 
the beach earlier that day, and you want to 
send everyone home with a freshly burned 
DVD. You can’t spend hours in the editing 
room—you want a movie now.

The Magic iMovie feature is for you. 
Choose a few options, then sit back and 
watch. iMovie HD imports video from 
your camera, adds an opening title, tosses 
a transition between each clip, adds a 
soundtrack from your iTunes library, and 
then ships the finished product off to 
iDVD. It’s editing on autopilot.

You can edit a Magic iMovie in any 
way you want, so you might also use the 
feature to create a rough cut. After iMovie 
HD gets you partway there, take the wheel 
and drive the rest of the way.

Is it magic? Hardly. But Magic iMovie 
is a fast way to spray some finish on your 
footage.

Notes: To use Magic iMovie, you must be using a 
DV or HDV camera; you can’t use an iSight or 
MPEG-4 camera with Magic iMovie. And if you just 
want to copy a tape to a DVD and don’t need tran-
sitions, titles, or a music soundtrack, check out the 
OneStep DVD feature in iDVD (page 299).

Magic iMovie: Editing on Autopilot

spread M19

Get a Head Start

If you’re using Magic iMovie to 

give you a head start in editing 

and you plan to trim clips after-

wards, consider unchecking the 

transition option. That way, 

iMovie HD won’t waste time cre-

ating transitions that you’ll end 

up deleting anyway. 

Tweaking Markers

Normally, the Magic iMovie  

feature places a DVD chapter 

marker at the beginning of each 

clip. If you don’t want to divvy up 

your movie into that many chap-

ters, remove some or all of the 

markers by using the iDVD pane 

in iMovie HD (see page 266).

Adding Magic to a 
Movie

You don’t have to use Magic 

iMovie with a brand-new movie 

project. If you use the Make a 

Magic iMovie command when an 

existing project is open, iMovie 

HD simply adds the magic movie 

to the end of the existing project.

Similarly, you can add a Magic 

iMovie to a different project by 

copying and pasting its clips. 

This can be a fast way to put 

together a montage destined for 

a different project. Create a new 

project, then make a Magic 

iMovie. Then, open a different 

project, switch to your Magic 

iMovie project, and choose 

Select All from the Edit menu. 

Finally, drag the clips from the 

Magic iMovie to the timeline or 

clips viewer of the new project.

Note: Copying clips from one 

project to another can take sev-

eral minutes and devour disk 

space. After the transfer is com-

plete, consider deleting the origi-

nal Magic iMovie project file to 

free up disk space.

Tips for Making Magic

To set the volume of your 
music soundtrack, use the  
volume slider in the Choose 
Music dialog box. If your video 
contains dialog or other impor-
tant audio, set the level fairly 
low to keep the music from 
overwhelming the other audio. 
Or, if your video contains noth-
ing but wind noise and car 
horns, set the slider at Music 
Only to have iMovie HD mute 
the audio from your footage. 
As with anything Magic iMovie 
does, you can change the vol-
ume level later if you like. For 
details on working with audio 
levels, see page 246.

To add a transition 
between every clip, 
check this box and 
choose a transition. 
Tip: Keep it tasteful 
and avoid the 
Random option.

To add a music 
soundtrack, check 
this box and click 
Choose Music  
(see Step 3  
opposite page).

If you plan to fine-
tune your movie 
before burning a 
DVD, uncheck  
this box.

Step 4.

Click Create. 

iMovie HD captures your video 
and prepares the movie.
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If you’re like the vast majority of iMovie 
HD users, you shoot and edit in the  
DV format—the most popular digital 
video format.

But iMovie HD isn’t limited to the DV 
format. As described on pages 224 and 
225, iMovie HD also lets you work in the 
HDV, iSight, and MPEG-4 formats.

As I mentioned previously, iMovie 
HD’s basic operation is identical regardless 
of which format you use. But there are 
some subtle differences between formats. 
Some formats use more disk space than 
others—a lot more. Some formats allow  
for device control—the ability to have 
iMovie HD operate your camera’s mecha-
nism when importing or exporting video—
while others require different importing 
techniques.

Here’s a look at the differences you’re 
most likely to encounter as you work with 
iMovie HD, and some tips for using vari-
ous formats.

Working in Other Video Formats
HDV Differences

The HDV video standard provides 
two primary formats: 720p and 

1080i. Those not exactly lyrical names 
refer to the way the video is recorded. 
With 720p, each video frame is comprised 
of 720 horizontal scan lines, and the lines 
are painted on the screen progressively, 
one after the next, just as a computer 
screen works.

With 1080i, each frame contains 1,080 
horizontal scan lines. The scan lines are 
drawn in interlaced fashion, like standard-
definition TV: first the odd-numbered scan 
lines, then the even-numbered ones.

The 1080i format provides the best image 
quality, but its footage uses considerably 
more disk space than 720p footage. And 
because each video frame contains more 
data that iMovie HD must process, transi-
tions, effects, and titles take longer to ren-
der with 1080i footage.

MPEG-2 and intermediates. With HDV, 
video is stored in MPEG-2 format. 
Because of the way MPEG-2 data is struc-
tured, it can’t easily be edited on a frame-
by-frame basis. (See page 307 for an 
introduction to how MPEG-2 video is 
structured.)

In order to make MPEG-2 video editable, 
iMovie HD converts video into an interme-
diate format that is easily editable. This 
conversion process uses a compression 
scheme called the Apple Intermediate 
Codec (AIC).

It’s this process of converting incoming 
MPEG-2 that creates the “tape delay” 
importing effect I described on page 227. 
Only the fastest Macs are able to trans-
code MPEG-2 into AIC and display the 
video in real time. On slower Macs, 
iMovie HD stashes the MPEG-2 data on 
your hard drive and transcodes it at 
whatever pace your Mac is capable of.

A similar but much longer delay occurs 
when you export HDV video back to a 
camera, at which time iMovie HD must 
convert from the Apple Intermediate 
Codec to MPEG-2 format.

iSight Insights

Apple’s inexpensive iSight camera turns 
your Mac into a hard disk-based cam-
corder. Connect an iSight to a laptop 
Mac (or use the iSight built into the 
MacBook Pro or iMac), and you can 
shoot video anywhere. Shoot some iSight 
video, throw in some photos from your 
iPhoto library if you like, then ship the 
project off to iDVD.

Recording. To record video and audio 
with an iSight, first open its shutter and 
put iMovie HD into camera mode (click 

 ). Next, click the Record with iSight 
button to begin recording. To stop 
recording, click the button again.

Format reminder. You can record with 
an iSight camera regardless of the video 
format your project uses. But you’ll get 
the best results and use disk space most 
efficiently by choosing the iSight format 
when you create your project. If you 

record video into a project containing 
footage in a different format, iMovie HD 
will transcode the iSight video you record 
into your project’s format. (See the side-
bar on page 225 for more details.)

Speaking of disk space, if your project 
uses the iSight format, your video will 
use roughly 65MB per minute.

Weird video? If iMovie HD is displaying 
a distorted or oddly cropped iSight 
image, you may have an older camera 
that needs updating. Get the latest 
iSight software at www.apple.com/
isight/download.

iSight accessories. A couple of  
inexpensive accessories can make the 
stand-alone iSight a better iMovie HD 
companion. For starters, consider a tripod 
mount. Kaidan (www.kaidan.com) sells an 
iSight accessory kit that includes an 
adaptor that lets you mount an iSight on a 
tripod. Many clever iSight users have also 
created their own mounts using a few 
washers and bolts. Do a Google search 
for iSight tripod for some inspiration.

Another accessory you might want is a 
long FireWire cable to help you to get the 
camera further from your Mac—particu-
larly handy when you’re shooting out-
doors with a laptop Mac.

Using MPEG-4 Video

Many cameras can shoot video clips in 
MPEG-4 format. Gadget gurus are 
embracing Fisher’s FVD-C1 (shown here) 
and Sanyo’s VPC-C4, tiny still/video 
camera combinations that can shoot up 
to an hour of video on a memory card—
no tape needed. The video quality falls 
short of what you get from a miniDV 
camera, but it’s surprisingly good—and 
is far superior to the movie quality most 
digital cameras provide.

Importing. These cameras don’t  
provide FireWire interfaces and device 
control. To import their video clips, con-
nect the camera to your Mac’s USB  
jack, then locate the camera’s icon on 
your desktop. Open the icon, locate the  
video footage, and drag it into the  
iMovie HD window.

The same format reminder applies: if you 
import MPEG-4 video into a project that 
contains footage in a different format, 
iMovie HD will transcode the footage into 
the project’s format.
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Exporting to an 
HDV Camera

Exporting high-definition 
video to an HDV camera 

involves the same steps listed at left. 
The one significant difference involves 
time: as described on page 262, 
iMovie HD must transcode your fin-
ished video from the Apple Intermediate 
Codec into the MPEG-2 format used by 
HDV cameras, and mix down and com-
press the audio. This process can take 
a long time on slower Macs—several 
times the length of your movie.

Making VHS Dubs
To make a VHS dub of a movie, connect 
your camera’s video and audio outputs 
to the video and audio inputs of a video-
cassette recorder.

You may have to adjust a setting on the  
VCR to switch input from its tuner to its  
video and audio input jacks.

Once you’ve made the connection, put a 
blank tape in the VCR, press its Record 
button, and then play back your movie.

Tip: If you’ll be doing a lot of dubbing, 
look for a VCR that has front-panel 
audio and video input jacks, which elim-
inate the need to grope around the 
VCR’s back panel.

 

If your camcorder and VCR each provide 
S-video jacks, use them for the video 
signal. S-video provides a much sharper 
picture. If you use an S-video cable,  
use only the audio plugs of the camera’s 

cable; just let the yellow one  
dangle behind the VCR.

You’ve finished your epic—now what?  
You decide. If you don’t have a DVD 
burner, chances are you’ll export many of 
your movies back to tape. If you’re working 
in the HDV format and you want to view 
your work in its full, high-definition glory, 
you’ll have to export to tape—iDVD 
doesn’t yet support the emerging standards 
for high-definition video. 

Once you export a movie to tape, you 
can connect your camera to your TV and 
screen your efforts. Or, connect the camera 
to a videocassette recorder to make VHS 
cassette dubs of your movie.

It’s a Wrap: Exporting to Tape

Connect your miniDV camera to your Mac’s FireWire jack  
and put the camcorder in VTR mode. Be sure to put a blank  
tape in your camcorder, or fast-forward until you’re at a blank 
spot in the tape. Don’t make the mistake of recording over your 
original footage—you may need it again in the future.

Step 1. 
Choose Video Camera from the Share menu, or press Shift-1-E.

Step 2. 
Click the Videocamera button.  
Adjust settings as desired.

iMovie HD will add some black  
footage before and after your movie, 
eliminating the jarring jump from 
and to the camera’s blue standby 
screen. The preset values of one 
second probably won’t be long 
enough—add a few seconds of 
black before the movie, and at least 
five to 10 seconds of black after it.

Step 3. 
Click Share; iMovie HD puts your camera in record mode and 
plays back your movie, sending its video and audio data over  
the FireWire cable to the camera.

Exporting to a DV Camera

spread M21

Your camera included a cable that 
probably has a four-conductor plug 
on one end, and three RCA phono 
plugs on the other. Connect the 
four-conductor plug to the cam-
corder’s output jack (it will be 
labeled A/V In/Out or something 
similar). Connect the yellow RCA 
plug to your VCR’s video input jack, 
the red plug to the audio input jack 
for the right channel, and the white 
plug to the audio input jack for the 
left channel.

iM
ovie HD

: M
aking M

ovies
It’s a W

rap: Exporting to Tape
iMovie HD: Making Movies

264 265



Naming Chapters
For movies containing chapter markers, iDVD 
creates a “Scene Selection” menu button. 
When your DVD’s viewers choose that button, 
they get an additional menu or set of menus 
that enable them to view each scene. 

Tips for 
Chapters
How might you use chapters? 
That depends on what’s in 
your video. Here are some 
scenarios to give you ideas.

A wedding video 
Create chapters for each of the 
day’s main events: the brides-
maids beautifying the bride, 
the groom arriving at the 
church, the ceremony, the 
reception.

A kid’s birthday party 
Create chapters for each phase 
of the party: the arrival of the 
guests, the games, the opening 
of presents, the fighting, the 
crying.

A vacation video 
Create chapters for each day or 
for each destination you visited.

A documentary 
Create chapters for each of the 
main subjects or periods of 
time that you’re documenting.

A training video 
Create chapters for each sub-
ject or set of instructions.

A video podcast 
Create chapters for each new 
subject, or when you want a 
clickable image that leads to a 
Web page.

When you add a chapter marker, 
its name appears in the Chapter 
Title area of the Chapters pane. 
iMovie HD automatically names a 
chapter after the clip that appears 
at the marker’s location. When 
you use that movie in an iDVD 
project, iDVD names buttons 
according to the chapter titles.

If you haven’t named your clips as 
I recommend on page 228, you 
can wind up with meaningless 
chapter titles and button names, 
such as Clip 03 or, for iPhoto 
images, Roll 86-2. 

Even if you have named  
your clips, you might still want 
different button names. You can 
always edit button names in 
iDVD, but you can also edit chap-
ter titles in iMovie HD: simply 
double-click on the chapter title 
and then type a new name.

If you’re creating a video podcast, 
you can embed a URL that dis-
plays for eight seconds. Double-
click the Link URL field, then  
type a Web address (including 
the http:// part). When the viewer 
clicks that chapter in iTunes,  
the Web page opens in a new 
browser window.

Each marker 
becomes a but-
ton, and each 
button’s name 
corresponds to 
the chapter title. 
Notice that 
iMovie HD auto-
matically creates 
a marker for the 
very beginning  
of the movie.

Tip: To quickly rename a chapter marker, select 
it and press Return. You can move from one 
marker to the next by using the up-arrow and 
down-arrow keys. By combining the arrow keys 
with the Return key, you can rename markers 
without having to reach for the mouse.

DVD chapters let you view video on your 
own terms. Whether you’re watching a 
Hollywood blockbuster or a DVD created 
by a friend, you can use on-screen menus to 
instantly access scenes of interest. You can 
also use the Next and Previous buttons on 
your DVD player’s remote control to jump 
to the next chapter or to return to the 
beginning of a chapter and watch it again.

By adding chapter markers to your 
movies, you give your viewers this same 
freedom of movement and spare them the 
tedium of fast-forwarding and rewinding. 
You can create up to 99 markers in iMovie 
HD, and iDVD will create menus and 
buttons for them.

Chapter markers are also instrumental 
when creating video podcasts (see page 354), 
letting viewers skip to sections in the video.

Chapter markers can be handy within 
iMovie, too. You can use them as book-
marks that help you quickly navigate 
through a lengthy movie: when you click  
a chapter in the Chapters pane, iMovie 
HD immediately moves the playhead to 
that location in the timeline. (You can, of 
course, also use bookmarks as bookmarks. 
But iMovie HD doesn’t display a list of 
bookmarks in one place as it does with 
chapter markers.)

You don’t have to create chapter mark-
ers in sequential order. If you add a 
marker to a movie that already contains 
some markers, iMovie HD automatically 
renumbers any markers that are located  
to its right.

Creating Chapter Markers
Adding Chapter Markers

Step 1. 
Position the playhead at the location where you want the chapter 
marker. Note that you can’t have a chapter marker within the first 
one second of a movie, and that there must be at least one sec-
ond between chapter markers.

You can drag the playhead there or use the keyboard shortcuts 
described in “The Keys to Precision” on page 229.

Step 2. 
Click the iDVD button.

The Chapters pane appears.

Step 3. 
Click the Add Marker button.

Repeat these steps for each chapter marker you want to create. 
Tip: You can also create a chapter marker by choosing  
Add Chapter Marker from the Markers menu or by pressing 
Shift-1-M. 

In the timeline viewer, iMovie HD displays a yellow 
diamond  at each chapter marker’s location.
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To Email a Movie
Step 1.

Choose Email from the Share menu. Specify the 
settings shown below, then click Share.

Name your shared movie.

To share only some clips, select them  
before choosing Share, then check this box.

Step 2.

iMovie HD compresses the movie and attaches it 
to a new email message. Compose and address 
the message, then send it on its way.

Tips

If your movie is short and your connection is fast, 
you might want to email a larger version of the 
movie than iMovie HD creates. Click QuickTime in 
the Share dialog box, then choose the Web option 
from the pop-up menu (see page 270). Export 
the movie, then attach it to an email message.

Many Internet providers restrict the size of 
attachments—often to 4MB or thereabouts. If 
your compressed movie is that large, it’s better 
to share it via iWeb.

To Share to an iPod

Step 1. 

Choose iPod from the Share menu, then click the 
Share button.

Step 2. 

After iMovie HD compresses the movie, it copies  
the movie to your iTunes library. Use iTunes to copy 
the movie to your iPod. For details on viewing video 
on the iPod, see page 96.

 
Note: 16:9 movies don’t cleanly fit the 
proportions of the iPod’s screen; the  

movie will be letterboxed with borders above and 
below the image.

First things first: the Internet isn’t the  
best medium for sharing digital video.  
The huge size of digital video files means 
that anything but a very short movie will 
take a long time to transfer, particularly 
over a modem line.

 But if you have made a very short 
movie—or you have a fast Internet connec-
tion and expect that your viewers will, 
too—you can use iMovie HD to prepare 
your work for cyberspace.

With the Share command, you can 
email a movie, send it to iWeb for viewing 
on your Web site, or prepare it for a video-
capable iPod. iMovie HD compresses the 
movie heavily to make its file size smaller. 
In the process, you get an introduction to 
The Three Musketeers of Internet video: 
jerky, grainy, and chunky.

A movie compressed for the Internet 
contains fewer frames per second, so 
motion may appear jerky. The movie’s 
dimensions are also much smaller—as 
small as 160 by 120 pixels, or roughly the 
size of a matchbook. And depending on 
the options you choose, the sound quality 
may not be as good as the original.

The best way to watch a movie is on a 
big screen. But if you’re willing to trade 
some quality for the portability of an  
iPod or the immediacy of email or the 
worldwide reach of the World Wide Web, 
iMovie HD is ready.

Go Small: Internet and iPod Movies

Like iPhoto, iMovie HD 
lets you use any of 
several popular email 
programs. Choose 
yours here.

Read it and weep: 
iMovie HD tells you  
just how much your 
movie will be mangled 
and how big the man-
gled version will still be. 
(Of course, your original 
movie is still stored in 
its original format.)
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To Share to iWeb
In iLife ’06, iWeb is the vehicle for publishing your  
movies to the Web.

Step 1.

Choose iWeb  
from the Share menu.

Step 2.

Choose to publish the movie on a Web page or as a  
video podcast as a video podcast. The video podcast 
option provides higher quality; you can read the specific 
settings each option uses above the buttons themselves. 
After you choose the option that’s best for your video, 
click Share or press Return.

After iMovie HD compresses the movie, it switches  
to iWeb, where you complete the publishing process  
(see page 382).
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Exporting a QuickTime Movie

To export your project as a QuickTime movie, 
choose QuickTime from the Share menu, or press 
Shift-1-E, and then click the QuickTime button.

Choose a preset from the pop-up menu.

 

To specify custom compression settings,  
choose Expert Settings.

Expert advice. You can often improve on the  
picture quality provided by iMovie HD’s Email, 
Web, and CD-ROM presets by using the Sorenson 
Video 3 compression scheme. To access it, hack 
through the following thicket of dialog boxes. In 
the Save dialog box that appears after you click 
Share, choose Movie to QuickTime Movie from the 
Export pop-up menu, then click the Options but-
ton. The Movie Settings dialog box appears; click 
Settings. In the next dialog box, choose Sorenson 
Video 3 from the pop-up menu. Now click OK sev-
eral times to go back to safety. If you like, explore 
the rest of the Movie Settings dialog box—it’s 
where you can specify the movie’s pixel dimen-
sions and sound settings.

To learn about compression, see iMovie HD 6 & 
iDVD 6 for Mac OS X Visual Quickstart Guide, by 
Jeff Carlson (Peachpit Press, 2006). For more 
QuickTime resources, see www.macilife.com/imovie.

Bluetooth is a wireless technology that 
connects devices over distances of up to 
about 30 feet. You can buy cell phones, 
printers, palmtop computers, keyboards, 
and mice that use Bluetooth’s radio 
waves instead of cables to talk to each 
other and to the Mac.

All current Mac models have built-in 
Bluetooth. If yours doesn’t, you can add 
Bluetooth using a tiny and inexpensive 
adapter such as the D-Link Bluetooth 
USB Adapter, which plugs into any free 
USB port on your Mac.

Mobile multimedia. Having Bluetooth is 
just one part of the mobile movie equa-
tion. Another part is a multimedia stan-
dard called 3GPP, which is supported by 
a growing number of cell phones and 
other gadgets. QuickTime supports 
3GPP, too, and it’s this support, com-
bined with Bluetooth, that makes it  
possible to play a movie on a phone.

To play a 3GPP movie, you need a  
3GPP media player for your device.  
Two such players are Kinoma Player 

(www.kinoma.com) and RealNetworks’ 
free RealPlayer (www.realnetworks. 
com/mobile).

Making the transfer. Be sure your 
phone is on, then choose Bluetooth from 
the Share menu. In the Share dialog box, 
click the Bluetooth button, then click 
Share. iMovie HD compresses your 
movie, then displays a dialog box for 
transferring it.

To have your Mac search for nearby 
Bluetooth devices, click Search.

Select the device to which you want  
to transfer the movie.

Your phone may display a message ask-
ing if you want to receive the movie. 
Choose Yes.

After the transfer is complete, navigate  
to your phone’s messages menu, choose 
the new message, and watch the show.

Tip: iMovie HD saves the compressed 
movie on your hard drive; you can use 
Mac OS X’s Bluetooth File Exchange 
program to transfer the movie again. 
Inside your movie’s package file (see  
page 274) is a folder named Shared 
Movies. Inside that folder is a folder 
named Bluetooth. Your compressed 
movie is there; its name ends with the 
file extension .3gp.

If you have numerous Bluetooth devices, 
you can narrow down the list of devices 
displayed by choosing the device category.

After choosing a device, click Select.

To play a 3GP movie on a Palm 

OS device, you need player soft-

ware that supports the 3GP for-

mat. Some Palm OS devices, 

such as the Treo 650 smart-

phone, can play 3GP movies 

right out of the box. If your 

device can’t, try Kinoma Player 

(www.kinoma.com), a versatile 

mobile media player that handles 

3GP and other formats.

With Kinoma’s inexpensive 

Kinoma Producer, you can com-

press a movie created in iMovie 

HD into a variety of mobile for-

mats. To do so, locate the 

Timeline Movie.mov reference 

movie for your project using the 

instructions on page 276.  

Drag this icon into Kinoma 

Producer, choose the desired 

audio and video settings, and 

click the Convert Files button. 

You can use Bluetooth File 

Exchange to transfer the com-

pressed movie to your Palm.

A Movie In Your Palm

Exporting to a Bluetooth Device

Amid the police lineup of the Share dialog 
box are two buttons that represent iMovie 
HD’s geekier sharing features. 

With the QuickTime button, you can 
export your project as a QuickTime movie. 
You might export a QuickTime movie in 
order to publish it on a Web site or burn it 
on a CD (page 276). Or you might want to 
email a movie to someone but use your 
own compression settings instead of those 
applied by iMovie HD’s Email preset.

With the Bluetooth button, you can 
transfer your movie to a cell phone or other 
gizmo equipped with Bluetooth wireless 
technology. An iPod is a better venue for a 
portable movie, but watching a movie on a 
phone is great geek fun.

Just remember to switch off your movie 
theater when the aircraft is not stopped at 
the gate.

More Ways to Share Movies

Exporting widescreen. If you’re 
exporting a 16:9 project, the movie 

dimensions listed in the Share dialog box are  
inaccurate—they’re for 4:3 movies. Your exported 
16:9 movie will have the horizontal dimension 
listed in the dialog box, but the vertical dimension 
will be shorter.

If you’re using the Expert Settings option 
described at right, specify a movie dimension of 
720 by 405 pixels (or a multiple thereof).
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Step 1. Trim as Needed

Once you’ve chosen a video clip for this project, 
trim its start point so the clip begins at the most 
appropriate spot. For example, if there are a few 
seconds of jerky camera movement before Junior 
starts opening presents, crop or direct-trim the 
clip to remove the bad footage.

Step 2. 
Create a Still Frame

Now select the trimmed clip and position iMovie 
HD’s playhead at its very first frame. The easiest 
way to make sure the playhead is at the very 
beginning of the clip is to press the Home key.

Next, choose Create Still Frame from the Edit 
menu. iMovie HD creates a new clip—a still 
image from the first frame—in the Clips pane.

spread M25

Play it back if you like: select it and 
press the spacebar.

A still frame always 
has a duration of five 
seconds. To change 
its duration, double-
click the clip and 
specify a new value 
in the Clip Info dialog 
box. You can also 
adjust the duration in 
the timeline, as 
described on the 
opposite page.

Step 3. Add the Still Frame 
to the Timeline

Before applying the effect, add the freeze- 
frame clip to the timeline by dragging it from the 
Clips pane.

Step 4. Add the Effect

Now you’re ready to alter the appearance of the 
freeze frame. If you’re after a nostalgic look, try 
the Aged Film effect—it makes a clip look like a 
scratched, jittery movie.

Select the freeze-frame clip in the timeline, click 
the Editing button, then click the Video FX button 
to bring up iMovie HD’s Video FX pane. Click the 
Aged Film effect.

Adjusting the Effect Out setting. For this proj-
ect, you want the effect to fade away shortly 
before the end of the clip; this enables the freeze 
frame to blend cleanly with the live-action clip  
that will follow it.

To make this adjustment, drag the Effect Out  
slider to the right. As you drag, watch the  
numbers in the slider’s text field. This value tells 
you how much time it will take for the effect to 
fade away. Try a setting of about one second, 
or 1:00. You can always adjust this setting later.

After you’ve adjusted the Effect Out setting,  
fine-tune any of the effect’s other settings if you 
like. When you’re done, click the Apply button. 
iMovie HD displays a message telling you that the 
still clip must be converted into a “regular” clip. 
Click Convert, and iMovie HD renders the frames 
required to create the effect. 

Step 5. 
Add the Original Clip

If you haven’t yet added your original clip—the 
one from which you extracted the video frame—
do so now. Select it in the Clips pane, then drag it 
to the timeline, positioning it immediately after the 
freeze-frame clip.

Now sit back and admire your work. First, be sure 
no clips are selected (choose Select None from 
the Edit menu or just click in a blank area of the 
timeline). Move the playhead to the beginning of 
the freeze-frame clip and press the spacebar to 
begin playback.

Optional steps. Does your freeze-frame clip seem 
too long? To shorten its duration, trim the clip: in 
the timeline view, point to the clip’s left edge, then 
drag to the right. For extra precision, use the 
Zoom slider to zoom in first.

iMovie HD doesn’t limit you to just one effect. 
Maybe you’d like that aged film clip to appear in 
black and white. It’s easy: select the freeze-frame 
clip in the timeline, return to the Effects pane, and 
apply the Black & White effect.

To add a title to the freeze-frame clip, use the 
Titles pane as described on page 254.

Position the original clip 
immediately after the 
modified freeze frame.

Variations on a frozen 
theme. You can also 
turn this trick around: 
have a scene suddenly 
freeze and then turn 
into a old movie frame. 
This can be a fun way 
to end a scene.

To do it, save a frame 
from the last frame of a 
clip. Adjust the Effect In 
setting of the freeze 
frame’s effect so that 
the effect appears after 
a second or so. Then, 
put the modified freeze 
frame after the clip 
from which it came.
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You see it all the time in movies and TV 
shows: a scene begins with the action fro-
zen, and suddenly the still image springs to 
life. The frozen image often has a special 
effect, too—maybe it’s been altered to look 
like a faded photograph. When what 
appears to be an old photo suddenly turns 
Technicolor and starts moving, the effect 
can be magical.

In Hollywood, they use expensive 
equipment and expensive artists for cine-
matic tricks like this. You can do it for  
free using iMovie HD, and it’s a cinch. 
Simply save a still image from the very 
beginning of a particular clip, then apply 
one or more effects to it. Once you’ve 
altered the freeze frame, it just takes a few 
clicks in the iMovie HD timeline to com-
plete the effect.

This effect can be a fun way to intro-
duce an event that just screams nostalgia—
a kid opening presents, a family sitting 
down to a Thanksgiving feast, or some 
kids hitting a slope for some sloppy sled-
ding. Start your scene with this effect, 
superimposing some title text if you like, 
and you’ve instantly gone beyond a run- 
of-the-mill home movie.

Fun with Freeze Frames

Fun w
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Many of iMovie HD’s visual effects are 
candidates for sound effects, too. Pair the 
Fairy Dust effect with the Stardust sound 
effect. Combine the Electricity visual 
effect with the Electricity sound effect.

And if you’re adding a little tectonic 
action with the Earthquake effect, try 
using the Suspense sound effect along 
with it.

You get the idea: think about enhancing 
your visual effects with complementary 
sound effects that add impact.

Movies from Your  
Digital Camera

You can add movie clips taken by a digi-
tal camera to your iMovie HD projects. If 
a movie you want is in your iPhoto library, 
you can locate it using iMovie HD’s photo 
browser. If the movie isn’t in your library, 
simply locate its icon on your hard drive 
and drag it into the iMovie HD window.

But let’s step back and look at the 
greater question: why bother? Compared 
to the quality you get from a real video 
camera, the movies from most digital 
cameras look genuinely awful.

And yet there are some good reasons to 
consider using a digital camera movie in 
an iMovie HD project.

It’s all you have. If you don’t have a 
camcorder but want to include some 
video in a movie project (as opposed to 
still photos and Ken Burns clips), use 
your digital camera. Adjust its menu set-
tings to get the largest frame size and 
highest quality your camera is capable of. 
iMovie HD enlarges the video frames to 
fill the screen, so you’ll get better results 
from larger movies.

For a special effect. Video producers 
often spend big bucks to get video that 
looks pixilated and has jerky motion. 
With digital-camera movies, those 

“effects” are standard equipment. Have 
a video camera? Shoot some footage 
using it and your digital camera’s movie 
mode. Then cut between the two for a 
cool effect.

For the sound. When I was in Paris, I 
wanted to capture the sound of the many 
street musicians who play in Metro sta-
tions. I shot digital camera movies, then 
brought them into iMovie HD and 
extracted their audio tracks (see page 
250). Then, I added still photos of the 
street musicians to the timeline and 
applied the Ken Burns effect to the pho-
tos. The result: a montage of still photos 
with an authentic soundtrack.

Incidentally, if you have a Sony digital 
camera and you’re having trouble import-
ing its MPEG movie clips into iMovie HD,  
see www.macilife.com/imovie for a  
workaround.

Copying and Pasting Clips

You can make additional copies of a clip 
by copying it to the Clipboard and pasting 
it into the Clips pane or the timeline. If you 
want to experiment with different effects 
or cropping schemes, select the clip and 
choose Copy. Next, select another clip on 
the Clips pane and choose Paste. iMovie 
HD makes a copy of the clip and puts it 
on the Clips pane for you. Another way to 
duplicate a clip is to press the Option key 
while dragging the clip—either to another 
box in the Clips pane or in the timeline or 
clip viewers.

You can even move clips from one project 
to another by copying and pasting them, 
though it’s often easier to simply open 
both projects and drag clips between 
them. If you paste clips into a project that 
uses a different video format, iMovie HD 
transcodes the clips into the destination 
project’s format. 

Moving Clips Faster

If you need to move a clip a significant 
distance—say, from the end of a project 
to the beginning—you could just drag it 
and let the clip viewer or timeline scroll 
automatically. But there’s a faster way. 
Drag the clip from the clip viewer or 
timeline into any empty box on the Clips 
pane. Scroll to the new destination, and 
then drag the clip from the Clips pane 
back into the clip viewer.

Multiple Clips at Once 

Remember that iMovie HD lets you select 
and manipulate multiple clips at once. 
You can apply the same effect, transition, 
or Ken Burns settings to several clips in 
one fell swoop. Just Shift-click to select 
a continuous range of clips, and 1-click 
to select clips that aren’t next to each 
other. To select a series of similar 
clips—for example, all transitions—
select one clip and then choose Select 
Similar Clips from the Edit menu.

Creating Color Clips

Want to create a text title with a back-
ground other than black? Here’s how.

In the timeline viewer, drag any clip to 
the right to create a gap.

 
Control-click on this gap and choose 
Convert Empty Space to Clip from the 
shortcut menu. iMovie HD turns the gap 
into a clip whose color is black.

To change the clip’s color, double-click 
the clip, then click the Color swatch in 
the Clip Info dialog box. (While you’re 
there, consider giving the clip a descrip-
tive name, such as Blue Background.)

Now you can add a title to this clip.  
You can also use the previous tips to 
move the color clip to the Clips pane, or 
make duplicates of it for use elsewhere 
in your project.

Another Way to Freeze 
Frames

You can also save a frame as a JPEG or 
PICT file for use in another program. 
Position the playhead at the frame you 
want to save, then choose Save Frame 
from the File menu (1-F). In the Save 
dialog box, choose the JPEG or PICT for-
mat from the pop-up menu.

You can add JPEG frames to your iPhoto 
library and even make and order prints. 
However, the images are small, so don’t 
expect to get high-quality prints in large 
sizes. You can email them, though, and 
that can be a fun way to share a few 
particularly good frames.

Combining SFX with FX

In the movie world, SFX are sound effects, 
while FX are visual effects. As anyone 
who has watched a Hollywood blockbuster 
knows, they go together perfectly.

iMovie HD Tips

Get Around 
Faster

Take advantage of iMovie HD’s 

View menu to quickly navigate  

a large project. If you’ve scrolled 

a large distance and want to 

jump back to the playhead’s loca-

tion, choose Scroll to Playhead 

(Option-1-P). The Scroll  

to Selection command (Option-

1-S) lets you quickly jump back 

to a selected clip. Zoom to 

Selection (Option-1-Z) zooms in 

on the selected clip or clips.

And if you’re using bookmarks, 

you can jump to the previous 

bookmark by pressing 1-[  

and to the next bookmark by 

pressing 1-].

Control Your  
Clicks

Remember that you can Control-

click on just about anything to 

bring up a shortcut menu that 

lets you perform relevant tasks. 

Try Control-clicking on a clip in 

the Clips pane, the playhead, the 

scrubber bar beneath the iMovie 

HD monitor, and on audio and 

video clips in the timeline.

Navigation Tips
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Get links to iMovie HD add-ons.
www.macilife.com/imovie

reason is because the video frame size is 
smaller—352 by 240 pixels, instead of 
DVD’s 720 by 480. Another reason is 
that the video itself is compressed more 
heavily—about 90:1, compared to 
roughly 30:1 for MPEG-2. But on the 
plus side, a Video CD can shoehorn 
about an hour of video onto a CD-R disc.

A variation of the Video CD format is 
called Super Video CD, or SuperVCD. On 
a SuperVCD, video is stored in MPEG-2 

format, yielding better quality than a Video 
CD. The SuperVCD format also allows for 
many DVD-like features, such as alternate 
language tracks. Its video quality still  
falls short of a DVD’s, however.

Video CD and SuperVCD are second-best 
alternatives to DVDs, but if you don’t have a 
DVD burner, any alternative is better than 
none. For background on the Video CD and 
SuperVCD formats, see www.vcdhelp.com.

Adding On to iMovie HD

Several companies sell inexpensive add-
ons that expand iMovie HD’s repertoire of 
effects, titles, and transitions. Companies 
offering iMovie HD add-ons include Virtix, 
GeeThree, and Stupendous Software. Each 
of these companies also offers free iMovie 
HD effect plug-ins. For links to more plug-
ins, see www.macilife.com/imovie.

The best way to see how your 

video will look on TV is to watch 

it on TV while editing it. iMovie 

HD makes it easy. First, connect 

your DV camcorder to the Mac 

with a FireWire cable as usual. 

(Note: This works with the DV 

format only, not HD.)

Next, connect your camcorder’s 

video output to the video input  

of a TV set. If your TV and 

camcorder each have S-Video 

connections, you should use 

them for the best video quality.  

If your TV lacks S-Video but has 

a composite video input (an RCA 

jack), use it. If your TV lacks 

video inputs, add an RF modula-

tor between the camcorder and 

the TV set. You can buy the 

modulator at Radio Shack for 

about $30. 

Once you’ve made the connec-

tions, choose Preferences from 

the iMovie HD menu, click 

Playback, and then check the 

Play DV Project Video Through  

to DV Camera box.

When this option is selected, your 

project’s audio will not play back 

through your Mac’s speakers. You 

can rely on your camcorder’s tiny, 

built-in speaker for sound play-

back, but you might want to 

connect your camcorder’s audio 

outputs to your TV’s audio inputs, 

if it provides them; to a stereo 

system; or to a pair of external 

amplified speakers.

Adjusting playback quality. 
While you’re setting playback 

preferences, examine the options 

iMovie HD provides for optimizing 

playback. If your Mac is stuttering 

on a complex project, consider 

downshifting to the Standard 

quality setting. Have a fast Mac? 

Aim high and choose Highest. 

Editing Like the Pros: Making the TV Connection

Archiving a Project

If you’ve created a fairly short project, 
you can archive it on a CD or (more 
likely) DVD. Choose Burn Project to Disc 
from the File menu, then insert a blank 
disc when iMovie HD tells you to. iMovie 
HD burns your project file to the disc. 
When it’s done, you can free up disk 
space on your hard drive by deleting the 
project file.

Unfortunately, if the project is larger than 
will fit on a single disc, you can’t archive 
it using Burn Project to Disc. Instead, 
back up the project by copying it to a  
different hard drive.

Accessing Your Project’s 
Media

In older iMovie versions, a movie project 
was stored in a folder, and its media 
assets, reference movies, and shared 
movies were stored in a folder within it.

iMovie HD works differently. Its project 
files are packages, a special kind of  
Mac OS X folder. That’s good in that it 
makes it easy to back up a project (just 
drag its icon to another hard drive) and 
makes it difficult for iMovie HD newcom-
ers to damage a project by removing or 
altering files they shouldn’t.

But as I’ve mentioned on previous pages, 
sometimes you need to get to the innards 
of a project. You still can: at the Finder, 
Control-click on a project icon and 
choose Show Package Contents from the 
Shortcut menu. The window that appears 
contains your project’s timeline file, 

source media, and shared movies (ones 
you created using the Share command).

In the Cache folder is a movie named 
Timeline Movie.mov. This is your project’s 
reference movie—it’s a QuickTime movie 
containing pointers to the media used in 
your project. You can drag this reference 
movie into a compression utility such as 
Kinoma Producer or Sorenson Squeeze.

iSight as Microphone

If you have an iSight camera, you can 
use it as a microphone to record narra-
tion. For the best sound quality, hold the 
iSight several inches from your mouth 
and talk to the top of the camera—that’s 
where the microphone is. Put iMovie HD 
into camera mode as described on page 
263, then click Record With iSight.

Add the clip you recorded to the timeline, 
then Control-click on it and choose 
Extract Audio. Delete the video portion  
of the clip, then move the audio to the 
desired location on the timeline.

Exporting Your  
Movie’s Sound

There may be occasions when you want 
to export part or all of the audio track of 
your project. Maybe you want to bring it 
into an audio-editing program, such as 
SoundStudio or Amadeus, for fine-tuning. 
Or maybe you recorded a music recital 
and you’d like to bring the performance 
into iTunes or GarageBand.

To export your project’s soundtrack, 
choose QuickTime from the Share menu, 
choose Expert Settings, and click Share. 

In the Save dialog box that appears, 
choose Sound to AIFF from the Export 
pop-up menu. Click Options, then choose 
the desired audio settings.

If you’ll be bringing your audio back  
into iMovie HD, use the default options.  
If you’ll be importing the audio into 
iTunes or GarageBand, choose 44.100 
from the Sample pop-up menu.

Burning Movies to CD 
and Video CD

If your Mac has a CD burner, you might 
want to burn your exported movie to a CD 
so you can share it with others. In the 
Share dialog box, click QuickTime, then 
choose the CD-ROM option. Next, insert 
a blank CD into your Mac’s optical drive 
and copy the movie to the CD. The result-
ing CD will play on any Mac or Windows 
computer that has QuickTime installed.

If you have Roxio’s Toast software, you 
can also create a Video CD. This video 
format is very popular in Asia, and some-
what obscure everywhere else. But most 
stand-alone DVD players can play Video 
CDs, as can all current personal comput-
ers. (To play Video CDs on a Mac, use 
Mireth Technology’s MacVCD X software, 
available at www.mireth.com. And if  
you don’t have Toast Titanium, you can 
also make Video CDs using Mireth 
Technology’s iVCD.)

Video on a Video CD is compressed in 
MPEG-1 format. The image quality is a 
far cry from that of the MPEG-2 format 
used on DVDs; Video CD image quality is 
more akin to that of VHS videotape. One 

More iMovie HD Tips

spread M27
iM

ovie HD
: M

aking M
ovies

M
ore iM

ovie HD Tips
iMovie HD: Making Movies

276 277



Somewhere in your closet is a 

full-sized VHS camcorder—the 

kind that rested on your shoulder 

like a rocket launcher. You want 

to get that old VHS video into 

your Mac.

If you have a DV camera, 

chances are it has a pass-

through mode that enables you 

to use it as an analog-to-digital 

converter. Connect the video 

and audio output jacks on the 

VHS deck to your DV camera’s 

video and audio input jacks. If 

your VHS deck and camcorder 

each provide S-video jacks, use 

them to get the best picture.

Next, put your camera in VCR or 

VTR mode, and read its manual 

to see if you have to perform any 

special steps to use its pass-

through mode. With some cam-

eras, you must make a menu 

adjustment. With others, you 

simply need to remove the tape.

After you’ve made the appropri-

ate connections and adjust-

ments, you can play your VHS 

tape and click iMovie HD’s 

Import button to record the 

converted footage coming from 

your camera.

Analog-DV 
Converter

A faster way to get analog video 

into your Mac is through a con-

verter, such as those sold by 

Formac Electronics, DataVideo, 

Sony, and others. These devices 

eliminate the time-consuming 

process of dubbing VHS tapes 

to DV format. Connect a con-

verter to your Mac’s FireWire 

jack, then connect your old VHS 

rocket launcher to the convert-

er’s video and audio inputs. 

Then, launch iMovie HD and use 

its import features to bring in 

VHS video. Using iMovie HD’s 

Share command, you can also 

blast edited video through the 

converter back to the VHS 

camcorder.

When importing VHS video, you 

may notice a thin band of flick-

ering pixels at the bottom of the 

image. Don’t worry: these arti-

facts won’t appear when you 

view your finished video on a 

TV screen.

Converting Films

As for those old Super 8 film-

based flicks, you’ll need to send 

them to a lab that does film-to-

video transfers. Many camera 

stores can handle this for you. 

The lab will clean your films, 

fix bad splices, and return them 

along with videotapes whose 

contents you can bring into the 

Mac. If you have a DV cam-

corder, be sure to use a lab that 

will supply your converted mov-

ies on DV cassettes—you’ll get 

much better image quality than 

VHS provides. Some labs also 

offer optional background music 

and titles, but you can add these 

yourself once you’ve brought the 

converted video into the Mac.

I wrote a feature article on digi-

tizing old tapes and movies for 

Macworld magazine’s June 

2004 issue. The article is avail-

able online; I’ve linked to it at 

www.macilife.com/imovie.

Second, light well. If you’re shooting 
indoors, consider investing in a set of 
video lights. A brighter picture com-
presses better than a poorly lit scene.  
To learn about lighting, read Ross 
Lowell’s excellent book, Matters of Light 
and Depth (Lowel Light, 1999).

Vary Shot Lengths

Your movie will be more visually engaging 
if you vary the length of your shots. Use 

longer shots for complex scenes, such as 
a wide shot of a city street, and shorter 
shots for close-ups or reaction shots.

Be Prepared, Be Careful

Be sure your camcorder’s batteries are 
charged; consider buying a second  
battery so you’ll have a backup, and  
take along your charger and power 
adapter, too. Bring plenty of blank tape, 
and label your tapes immediately after 

ejecting them. To protect a tape against 
accidental reuse, slide the little locking 
tab on its spine.

Don’t Skimp on Tape

Don’t just get one version of a shot, 
get several. If you just shot a left-to-right 
pan across a scene, for example, shoot  
a right-to-left pan next. The more raw 
material you have to work with, the better.

Converting Analog Video and Movies

Editing takes more than software. You 
also need the right raw material. Advance 
planning will help ensure that you have 
the shots you need, and following some 
basic videography techniques will make 
for better results.

Plan Ahead

Planning a movie involves developing 
an outline—in Hollywood parlance, 
a storyboard—that lists the shots 
you’ll need to tell your tale. Professional 
movie makers storyboard every scene 
and camera angle. You don’t have to go 
that far, but you will tell a better story if 
you plan at least some shots.

Consider starting with an establishing 
shot that clues viewers in on where your 
story takes place—for example, the 
backyard swimming pool. To show the 
big picture, zoom out to your camcorder’s 
wide-angle setting.

From there, you might cut to a medium 
shot that introduces your movie’s subject: 
little Bobby preparing to belly flop off the 
diving board. Next, you might cut away to 
Mary tossing a beach ball. Cut back to 
Bobby struggling to stay afloat, and then 
finish with a long shot of the entire scene.

Keep in mind that unless you’re planning 
to use the Magic iMovie feature, you 
don’t have to shoot scenes in chronologi-
cal order—sequencing your shots is 
what iMovie HD is for. For example, get 
the shot of Mary’s throw any time you 
like and edit it into the proper sequence 
using iMovie HD.

Steady Your Camera

Nausea-inducing camera work is a com-
mon flaw of amateur videos. Too many 
people mistake a video camera for a  
fire hose: they sweep across a scene, 
panning left and right and then back 
again. Or they ceaselessly zoom in and 
out, making viewers wonder whether 
they’re coming or going.

A better practice is to stop recording, 
move to a different location or change 
your zoom setting, and then resume. 
Varying camera angles and zoom 
settings makes for a more interesting 
video. If you must pan—perhaps  
to capture a dramatic vista—do so  
slowly and steadily.

And, unless you’re making an earth-
quake epic, hold the camera as steady 
as you can. If your camera has an 
image-stabilizing feature, use it. Better 
still, use a tripod or a monopod, or brace 
the camera against a rigid surface. 
Keeping the camera steady is especially 
critical for movies destined for the 
Internet—because of the way these  
videos are compressed, minimizing extra-
neous motion will yield sharper results.

Compose Carefully

The photographic composition tips 
on page 214 apply to movie making, too. 
Compose your shots carefully, paying 
close attention to the background. Get up 
close now and then—don’t just shoot 
wide shots.

Record Some 
Ambient Sound

Try to shoot a couple of minutes of  
uninterrupted background sound: the 
waves on a beach, the birds in the forest, 
the revelers at a party. As I’ve mentioned 
previously, you can extract the sound 
from this footage and use it as an audio 
bed behind a series of shots. It doesn’t 
matter what the camera is pointing at 
while you’re shooting—you won’t use 
the video anyway.

After importing the footage, use the 
Extract Audio command, described on 
page 250, to separate the audio.

Shooting with 
Compression in Mind

If you know that you’ll be distributing 
your movie via the Internet—either 
through a Web site or email—there are 
some steps you can take during the 
shooting phase to optimize quality. These 
steps also yield better results when 
you’re compressing a movie for playback 
on a Bluetooth device, and they even 
help deliver better quality with iDVD.

First, minimize motion. The more motion 
you have in your movie, the worse it will 
look after being heavily compressed. 
That means using a tripod instead of 
hand-holding your camera, and minimiz-
ing panning and zooming. Also consider 
your background: a static, unchanging 
background is better than a busy traffic 
scene or rustling tree leaves.

Tips for Making Better Movies

Learn more about digitizing old tapes and movies.
www.macilife.com/imovie
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For animators, patience isn’t a virtue—
it’s a must. Move objects slowly and 
gradually—just a fraction of an inch 
between frames. And whatever you do, 
don’t bump your tripod between frames.

To save time, try shooting two frames, 
instead of just one, between each move. 
Animators call this animating on twos, 
and it takes half the time but usually 
delivers fine results.

Kids in motion. For a variation on the 
previous theme, animate some kids: 
point the camera at the backyard, and 
have the kids take a small step between 
each frame. In the final movie, they’ll 
appear to move without walking.

Time for time-lapse. Making time- 
lapse movies is much easier, since your 
subject does the moving on its own. All 
you have to do is set up your scene and 
start capturing.

In iMovie HD, choose Time Lapse from 
the camera icon’s popup menu, choose 
an interval, and click OK. Then click 
Import to start recording (see page 226).

What to shoot? A snowstorm, a rose,  
the clouds, a burning candle, a glass 
filled with ice, the shadows cast by a 

fence or set of window blinds. Anything 
that moves or changes shape slowly in 
the real world is a great candidate for 
time-lapse photography.

Sunsets and sunrises make spectacular 
time-lapse movies. To avoid damaging 
your camera, don’t zoom in on the sun or 
point the camera directly at a midday sun. 

How frequently should you capture a 
frame? That depends on how quickly your 
subject is changing and on how long you 
want your final clip to be. For a time-lapse 
of a rose blooming, I used a one-minute 
interval, which turned an hour of real time 
into one second of video. For some cloud 
scenes, I used a 15-second interval.

To calculate the ideal frame interval, 
begin by determining the duration of the 
real event, the desired duration of your 
final clip, and the number of frames  
per second you want the final clip to 
have (20 frames per second is a good 
starting point). Say a rose bud takes  
four hours to blossom, and you want  
the time-lapse clip to play for nine sec-
onds. Multiplying nine seconds by 20 
frames per second yields 180 frames. 
Finally, divide the duration of the real 
event by the number of frames you need. 
In this example, 240 minutes divided by 
180 frames equals about 1.3 minutes—
or about 80 seconds between frames.

Post-Production

After creating an animation, enhance it.

Make a montage. When researching 
animation and time-lapse techniques, I 
shot a variety of time-lapse scenes,  
then edited them into a montage.

After shooting the clips and importing 
them into iMovie HD, I added a music 
track. I’ve always loved Koyaanisqatsi, a 
film comprised largely of beautiful time-
lapse photography; its Philip Glass music 
score is a perfect complement to time-
lapse scenes. A quick search of the 
iTunes Music Store led to the soundtrack 
album, and 99 cents later, I had my 
soundtrack. (Remember, you can’t use 
copyrighted work in commercial projects.)

Next, I imported my time-lapse movies 
into iMovie HD and added them to the 
timeline, cropping each clip so that the 
scenes would change roughly in tempo 
with the music. Then I added a cross-
dissolve transition between the scenes. 

Run it backwards. To put a different  
spin on a time-lapse clip, reverse it: see  
a rose close itself or a glass of water turn 
into a glass of ice. After adding the clip  
to iMovie HD’s timeline, select it and use 
the Fast/Slow/Reverse effect.

Our minds are mesmerized by animation, 
whether it’s a time-lapse movie of a brew-
ing storm, some claymation that brings 
Play-Doh to life, or the hand-drawn art-
istry of a classic cartoon.

With some inexpensive software and a 
video camera, you can put your world into 
motion. The process is simple, if time con-
suming. For animation, shoot one frame of 
video at a time, moving objects or chang-
ing a drawing between each frame. Time-
lapse movies are easier: point your camera 
at an interesting scene, then go to the mall 
while your software snaps a frame at what-
ever interval you like. When you play your 
final movie, clouds will billow, and flowers 
will bloom—you get the idea.

A time-lapse or animation project can 
be a fun school or family endeavor. Here’s 
a look at the tools you’ll need, along with 
some tips and project ideas.

Creating Time-lapse Movies and Animation
The Tools

To put your world in motion, you need a camera, a tri-
pod, and some software. To get the best video quality, 
connect a miniDV camcorder to your Mac’s FireWire 
jack. If you don’t have a camcorder, an inexpensive  
Web cam, such as Apple’s iSight, will also work.

iMovie HD 6 can create time-lapse movies, as can  
several other programs. Boinx Software’s iStopMotion 
was designed specifically for the task. It works with  
DV cameras as well as Web cams.

You can also use Web-cam software, such as 
Evological’s EvoCam or Econ Technologies’ 
ImageCaster. For links to these and other animation 
tools, see www.macilife.com/imovie.

The Techniques

Prepare your gear. Mount your camera on a tripod and 
plug the camera’s power adapter into a wall outlet—
batteries won’t last long enough.

Many DV camcorders shut themselves off after a few 
minutes when you aren’t recording to tape. You can usu-
ally bypass this auto-shutoff by taking the tape out of the 
camera. If your camera still insists on slumbering,  
try leaving its tape door open.

Connect the camcorder to your Mac, launch your soft-
ware, and you’re ready to go. Here are some possible 
destinations.

Toys in motion. For an easy stop-motion project, put 
some toys in motion: the Matchbox Car 500. For your 
animation stage, choose an area where the lighting is 
going to be fairly consistent over several hours. If you’re 
relying on light from windows, try to shoot on a cloudy 
day. Dramatic variations in lighting from one frame to 
the next will ruin the illusion of motion.
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